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1. Getting started

Integration overview

Integrating Lifecycle Visualization with Teamcenter

The Lifecycle Visualization integration with Teamcenter enables you to work with managed visualization

data in the external standalone application viewer or in the Lifecycle Viewer perspective in the rich
client. The standalone application viewer is a separate application from Teamcenter. It expands upon
Teamcenter's embedded visualization components with support for optional software modules such

as Concept Showroom, Visualization Illustration, and Variation Analysis. The Lifecycle Viewer is an
embedded visualization application within the rich client. It provides nearly all of the visualization tools
offered by the standalone viewer, many of which are not available for Teamcenter applications such as
My Teamcenter or Structure Manager.

Find more information on using the visualization products in Lifecycle Visualization viewers.

The following sections provide information on configuring and using the Lifecycle Visualization
integration with Teamcenter.

Before you begin

Prerequisites

Enable the Lifecycle
Visualization
integration

Configure
the Lifecycle

The Lifecycle Visualization integration with Teamcenter supports Teamcenter
lifecycle visualization standalone application viewer and the Lifecycle Viewer
within the rich client.

The standalone application viewer and the Lifecycle Viewer are available in

the Base, Standard, Professional, and Mockup product configurations. The Base
configuration is automatically installed with the Rich Client. Some optional
products are available only for the standalone application viewer, including
Variation Analysis, Concept Showroom, and Jack.

The Teamcenter FMS Client Cache (FCC) must be installed on the client
machine. This is automatically installed with the rich client.

You do not need Teamcenter administrator privileges to use the Lifecycle
Visualization integration with Teamcenter or to set Teamcenter user
preferences, but you do need Teamcenter administrator privileges to configure
preferences at the site level.

The Lifecycle Visualization integration with Teamcenter is part of the standard
Teamcenter deployment architecture. Refer to the Add lifecycle visualization
to the Teamcenter rich client topic in Installation in the Teamcenter help.
Teamcenter is installed using Teamcenter Environment Manager (TEM).

Teamcenter is installed and initially configured using Teamcenter Environment
Manager (TEM). After Teamcenter is installed, a number of configuration
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_ 1. Getting started

Visualization options exist that you can use to customize the Lifecycle Visualization
integration integration.

Start the Lifecycle If you are using the rich client, you can send visualization data into the
Visualization standalone application viewer or the Lifecycle Viewer.

integration

* To send visualization data to the standalone application viewer, select the
. . . . o . . . . "i".
item revision, and click Start/Open in Lifecycle Visualization & on the
toolbar.

* To send visualization data to the Lifecycle Viewer, right-click the item
revision, and choose Send To-)Lifecycle Viewer.

Lifecycle Visualization viewers

The Lifecycle Visualization integration with Teamcenter supports the Teamcenter lifecycle visualization
standalone viewer and the Lifecycle Viewer within the rich client. In addition, many rich client
perspectives include embedded visualization components.

Standalone viewer

The standalone viewer, which runs outside of Teamcenter and is a separate installation, expands upon
Teamcenter's embedded visualization components with support for optional software modules such

as Concept, Visualization Illustration, Quality Producer, and Variation Analysis. Standalone Lifecycle
Visualization is integrated with Teamcenter, so you can send data from Teamcenter applications into the
standalone viewer, perform analysis, and then save your work back to the database.

Standalone Lifecycle Visualization is available in the following product configurations:
* Base

The Base product configuration enables you to view and mark up 2D images and perform basic 3D
analysis operations such as measurements and cross sections.

e Standard

The Standard product configuration provides many additional features, such as advanced navigation
capabilities, markup tools, and support for precise 3D measurements.

* Professional

The Professional product configuration adds analysis functionality such as 3D comparisons, as well as
the ability to manipulate and transform 3D models, create outline captures, and play motion files that
illustrate assembly sequences. You can optionally use add-on modules such as Animation, Concept,
and Visualization Illustration.
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Lifecycle Visualization viewers _

* Mockup

The Mockup product configuration provides all of the functionality from the other product
configurations and also includes advanced features such as 3D Clearance analysis, geometry
simplification, part groups, 3D filters, and movie captures. You can optionally use all of the available
add-on modules, including Quality Producer, Variation Analysis, Jack, and Path Planning.

Lifecycle Viewer

The Lifecycle Viewer is a full-fledged visualization client within Teamcenter. It provides nearly all of the
visualization tools offered by the standalone viewer, many of which are not available in the embedded
viewers within Teamcenter applications such as My Teamcenter.

The Lifecycle Viewer is available in the same product configurations as the standalone viewer, Base,
Standard, Professional, and Mockup. Features available vary depending upon the licensing level. The
Base configuration is automatically installed with the rich client.

Using the Lifecycle Viewer, you can:

* Work within a comprehensive user interface that provides access to many of the options previously
available only with the standalone products, including menus and views (the equivalent of Project
Workspace windows such as the Assembly).

* Insert or merge files within active Viewing windows.
* Work with multiple open datasets.

* Preserve the state of your work with session files.

* Save data as PLM XML.

* Export 2D images and 3D models as supported datasets.

Author visualization data such as motion files, swept volumes, and .vfz collaboration files.
Working with visualization data in the My Teamcenter viewer

The Viewer view in My Teamcenter displays content dependent on the type of object selected in the
current component view or in the Details view. Support for visualization data includes:

* If anitem or item revision is selected, the viewer displays the associated image, printed circuit board,
schematic, or JT data.

* If an image, ECAD PCB, ECAD Schematic, or JT dataset is selected, the viewer displays the image,
printed circuit board, schematic, or model.

1-3



_ 1. Getting started

Visualization use cases

* View and markup of parts, printed circuit boards, schematics, drawings and images, without having to
launch the standalone viewer or the Lifecycle Viewer.

Visualization tools available

2D Markup
Create 2D markups.
* 2D Multipage
Navigate among pages in multiple-page 2D images or documents.
* 2D Viewing
Pan, zoom, rotate, and flip 2D images.
* 3D Markup
Create 3D markups.
* 3D Measurement
Perform 3D measurements.
* 3D Navigation
Pan, rotate, and zoom 3D models.
* 3D PMI
View and manipulate PMI in your model.
* 3D Section
Create 3D cross sections.
* 3D Selection
Select parts and pick part features.
* 3D Standard Views

Examine your model from preset viewing angles.
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Lifecycle Visualization viewers _

¢ ECAD Base

Manipulate the view of ECAD document layers, control layer color and visibility, search, and create
reports.

* ECAD Markup
Create ECAD markups.
* ECAD Multipage
Navigate among pages in multiple-page schematic documents.
* ECAD Viewing
Pan, zoom, rotate, and flip image.
* Print
Print documents.
Structure Manager viewer

The viewer embedded in Structure Manager is available within the Viewer tab of the data pane. The
viewer allows you to view JT files attached to assemblies and components in the structure tree when you
are viewing and editing a product structure.

Visualization use cases

View 3D assemblies or structures.

View subcomponents in an assembly.

» Compare product structures.

Create and save product views.
Visualization tools available
* 3D Alignment
Align parts with other parts in the viewing window.
* 3D Appearance

Change the appearance of 3D models.
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_ 1. Getting started

* 3D Clearance

Check the clearance of parts in 3D models.
* 3D Comparison

Compare the geometry of two sets of parts.
* 3D Coordinate System

Create and align parts to local coordinate systems.
* 3D GDT Markup

Create 3D GD&T markups.
* 3D Manipulators

Transform 3D models.
* 3D Markup

Create 3D markups.
* 3D Measurement

Perform 3D measurements.
* 3D Movie Capture

Capture your actions in the 3D viewing window as movie files.
* 3D Navigation

Pan, rotate, and zoom 3D models.
* 3D PMI

View and manipulate PMI in your model.
* 3D Section

Create 3D cross sections.

e 3D Selection
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Lifecycle Visualization viewers _

Select parts and pick part features.
* 3D Standard Views

Examine your model from preset viewing angles.
* 3D Thrustline Editor

Create and manipulate thrustlines.
» 3D Visibility

Hide obscuring parts and clip areas of your model.
Multi-Structure Manager viewer

The viewer embedded in Multi-Structure Manager is available within the Object View tab of the data
panel. The viewer allows you to view associated 2D images and 3D models when you are viewing and
editing a product or process structure.

Visualization use cases

View product or process structures.
* View images associated with objects selected on the structure tab.

* View and create markups.

Create and save product views.
Visualization tools available
* 2D Markup
Create 2D markups.
* 2D Multipage
Navigate among pages in multiple-page 2D images or documents.
* 2D Viewing
Pan, zoom, rotate, and flip 2D images.

* 3D Markup
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_ 1. Getting started

Create 3D markups.
* 3D Measurement
Perform 3D measurements.
* 3D Navigation
Pan, rotate, and zoom 3D models.
* 3D PMI
View and manipulate PMI in your model.
* 3D Section
Create 3D cross sections.
* 3D Selection
Select parts and pick part features.
» 3D Standard Views
Examine your model from preset viewing angles.
Manufacturing Process Planner viewer

The viewer embedded in Manufacturing Process Planner is available within the Object View tab of the
data panel. The viewer allows you to view associated 2D images and 3D models when you are viewing
and editing a process structure.

Visualization use cases

* View product or process structures.

* View images associated with objects selected on the structure tab.
* View and create markups.

* Create and save product views.

Visualization tools available

* 2D Markup
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Lifecycle Visualization viewers _

Create 2D markups.
* 2D Multipage
Navigate among pages in multiple-page 2D images or documents.
* 2D Viewing
Pan, zoom, rotate, and flip 2D images.
* 3D Markup
Create 3D markups.
* 3D Measurement
Perform 3D measurements.
* 3D Navigation
Pan, rotate, and zoom 3D models.
* 3D PMI
View and manipulate PMI in your model.
* 3D Section
Create 3D cross sections.
* 3D Selection
Select parts and pick part features.
» 3D Standard Views
Examine your model from preset viewing angles.
JT Preview view

The JT Preview view enables you to examine .jt parts associated with items, item revisions, and
datasets. When you select a compatible object, the .jt part is displayed in the view.

Visualization use cases

* Preview .jt parts.
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Visualization tools available
* 3D Navigation

Pan, rotate, and zoom 3D models.
Image Preview view

The Image Preview view enables you to examine 2D raster images associated with items, item revisions,
and datasets. When you select a compatible object, the image is displayed in the view.

Visualization use cases
* Preview 2D raster images.
Visualization tools available

* None

Basic concepts

Primary and secondary visualization documents

Visualization files in Teamcenter are always either primary or secondary documents. You can open
primary documents independently from other documents, while secondary documents are dependent
upon primary documents. For example, a JT file is a primary document, which you can view on its own
without any other file having to be open; a markup layer (VPL file), in contrast, cannot be viewed on its
own, and must be opened in the context of a primary document, such as a JT file.

Static and configured product structure

Product structure from Teamcenter can be either static or configured, depending upon how you save
and then subsequently re-open the session. When you initially send product structure into the Lifecycle
Viewer or the standalone application viewer, the structure matches the currently active configuration
settings from Teamcenter applications such as Structure Manager (revision rules, effectivity, variant
rules, active assembly arrangements, and other settings).

Visualization session files

Session files save the state of the viewer so you can resume your work later. Saving your work as a
session file enables you to preserve viewer elements such as open files, snapshots, part visibility, and
part transformations.




Note:

By default, in a four-tier environment, when you launch standalone Lifecycle Visualization from
the Teamcenter rich client, the viewer and the rich client share the same tcserver session. When
you perform standalone viewer operations, such as saving a session file, the rich client may appear
to lock up until the viewer operation is finished. If this is a problem, you can configure Teamcenter
to create a separate tcserver session for the standalone viewer.

Basic tasks

An understanding of how to complete the following tasks is helpful when first beginning to use the
Lifecycle Visualization integration with Teamcenter:

* Turn on the Ul options in the rich client to send visualization data to the standalone application
viewer.

* Use the Teamcenter Integration Preferences to specify the default behavior of visualization datasets in
Lifecycle Visualization.

* Open visualization files from Teamcenter in the standalone application viewer or the Lifecycle
Viewer.

* Insert or merge visualization files with an active session in the standalone application viewer or the
Lifecycle Viewer.

e Search the Teamcenter database from the standalone application viewer.

e Create shortcuts to folder locations in Teamcenter.
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2. Viewing 2D images and 3D models

2D and 3D visualization overview

The Lifecycle Visualization integration with Teamcenter enables you to work with managed visualization
data in the external standalone application viewer or in the Lifecycle Viewer perspective in the rich
client. If you are using the rich client, you can send visualization data into the standalone application

viewer or the Lifecycle Viewer.

Open visualization data from Teamcenter

You can open visualization data, including 2D images and 3D models, in the standalone viewer and the

Lifecycle Viewer.

Note:

the TC_show_open_in_vmu_button preference.

The options to send Teamcenter managed visualization data to the standalone viewer may
not be shown by default on the user interface of the rich client. For these options to be
displayed, you must enable them using the Lifecycle Visualization options in the rich client or

Do any of the following:

To

Send any of the following to the standalone
viewer:

e Anitem or item revision that includes
visualization data

* ABOM view

* Selected product structure

* Worksets

» A 3D dataset such as a JT file

* A 2D or ECAD dataset such as an image or PCB
file

Send any of the following to the Lifecycle Viewer:

Do this

Select the object and do one of the following:

* On the My Teamcenter toolbar, click Start/
Open In Lifecycle Visualization .

* Choose File»>Open in Lifecycle Visualization.

Right-click the object and click Send To->Lifecycle
Viewer.
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_ 2. Viewing 2D images and 3D models

To Do this

e Anitem or item revision that includes
visualization data

* ABOM view
* Selected product structure
* Worksets
* A 3D dataset such as a JT file
* A 2D or ECAD dataset such as an image or PCB
file
Working with product structure from Teamcenter

You can send a full or partial product structure from the Structure Manager to the Lifecycle Viewer or a
standalone viewer. Open the structure in a new Viewing window, insert the structure as a new assembly
in an active Viewing window, or merge the structure with an existing assembly in an active Viewing
window.

To send product structure to the visualization client, select the product structure within the Structure
Manager and then do one of the following:

* Click Start/Open In Lifecycle Visualization to send the product structure to a standalone viewer.

* Right-click the product structure and choose Send To->Lifecycle Viewer to send the product structure
to the Lifecycle Viewer.

To send a full product structure to the visualization client, select the root or top line of the product
structure. To send a partial product structure, select any child nodes within the root product structure
hierarchy. Partial product structure consists of the lines representing the unique paths down to the
selected structure.

Note:

When working with partial product structures, the following limitations apply:
* You can expand only the child hierarchy of the launched lines.

 All viewer operations, such as filters and Clearance analysis, are applicable only for the launched
lines.
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Inserting and merging files _

Note:

Teamcenter applications such as Structure Manager include view toggles that enable you to

see BOM lines that are configured out because of effectivity or variants. The view toggle Show
Suppressed Occurrences enables you to see BOM lines that are suppressed in the current
assembly arrangement. If you send an assembly to the standalone application viewer or the
Lifecycle Viewer when this view toggle is on, the suppressed structure elements are grayed out.
If you open a product view that captured suppressed occurrences, an inactive structure warning
is displayed. To avoid this problem, set the Product View Creation Preferences to prevent the
creation of product views when the Show Suppressed Occurrences view toggle is enabled.

Inserting and merging files

When you want to insert or merge a 2D, 3D, or ECAD file into an opened similar file format, the system
asks how you want to open the file. The following insert and merge options exist:

* Insert the file into the current window.
* Merge the file into the current window.
* Insert or merge the file into a new Viewing window.

The steps required to insert or merge files vary slightly depending upon the applications involved.
When working with local data in the standalone viewer, you must use the Application toolbar
Menu—File=Insert or File*Merge commands. When working with Teamcenter managed data, you
send the data you want to insert or merge into the standalone viewer or the Lifecycle Viewer, and then
specify how you want to open the data in the Load Option Preferences dialog box.

View related documents in My Teamcenter

When viewing a 3D model, you can open the associated item revision in My Teamcenter to access
additional information or attachments.

1. Display the product structure or part.

2. Inthe Assembly view, right-click the product structure or parts and choose Send to My
Teamcenter.

_or-
In the Viewing window, right-click the geometry and choose Send to My Teamcenter.

The associated item revision is opened in My Teamcenter.
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_ 2. Viewing 2D images and 3D models

Define Teamcenter User Areas

You can create shortcuts to folder locations in Teamcenter. When opening or saving files, you can go
directly to a location without browsing intervening directory structure.

1. On the File toolbar, click Open .

Tip:

If you have directories containing hundreds or thousands of files, it may take a while for the
complete list of files to appear. You can press Ctrl-Break (Windows) or Esc (Linux) to stop the
file listing at any point.

2. Inthe Open dialog box, browse to a location that you want to add to your User Areas.
3. Choose Tools—>Add Current Location To User Areas.

A folder representing the location appears within your User Areas.
4. Type a name for the User Area.

A shortcut to the specified location is created.

5. Toaccess a User Area, click User Areas in the shortcuts panel on the left side of the file dialog box.

Search the Teamcenter database

When opening, inserting, or merging files in the standalone viewer, you can search a mapped
Teamcenter server for datasets, item revisions, items, and parts.

1. From the File menu, choose one of the following:
* Open
* Insert
* Merge
2. From the shortcut bar of the dialog box, click Servers.
Your list of mapped servers appears.

3. Double-click the server you want to search to access it, and then choose Tools-»Search Server.
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Specify load option preferences _

4. In the Select Search section of the Server Search Dialog dialog box, select a search object.
Choose from the following types of searches:

* Dataset

* Item Revision

* [tem

* Part

The Enter Search Criteria section is populated with the available search variations.

5. Inthe Enter Search Criteria section, select a search criteria, type an appropriate search keyword,
and click Search.

The server is searched using the criteria you specified. When the search is completed, the Search
Results dialog box appears.

6. To open a search result, do one of the following:
¢ Double-click the search result

* Select the search result and then click Select.
Specify load option preferences
1. Choose File—>Preferences—>Load Options.

2. Inthe Load Option Preferences dialog box, choose from the following preferences:

¢ On the 3D tab:

In this

section Select this To
Product Open document Do one of the following:
Structure

* Open the document in a new window.

* (If the document is already open in a
window) display the window.

Insert document into active Insert the data into the currently active
window window.
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_ 2. Viewing 2D images and 3D models

In this
section Select this

Merge document into active

window

Ask at load time
Markups Open with markups

Ask at load time

¢ On the 2D tab:

Select this

Open document

Insert document into active window

Ask at load time

To

Merge the data into the currently active
window.

Note:

You can merge product structure only

if the data being sent is compatible
with the contents of the active Viewing
window. For structure to merge, the
data being sent to the visualization
client and the data in the active Viewing
window must share the following
structure configuration properties:

e Revision rule
* Root or top line

» Variant rule (if either set of data uses
a variant rule)

* Active assembly arrangement (if
either set of data uses arrangements)

Select your options each time you open a file.
Open markups associated with the data.

Select your options each time you open a file.

To

Do one of the following:
* Open the document in a new window.

* (If the document is already open in a
window) display the window.

Insert the data into the currently active
window.

Select your options each time you open a file.
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Select this To
Open with markups Open markups associated with the data.
Ask at load time Select your options each time you open a file.
* On the ECAD tab:
Select this To
Open document Do one of the following:

* Open the document in a new window.

* (If the document is already open in a
window) display the window.

Insert documents into active window Insert the data into the currently active
window.

Ask at load time Select your options each time you open a file.

Note:

* Selections are persisted each time the dialog box opens.

* The default settings for the Load Option Preferences dialog box are Ask at load time and
Merge document into active window.

* For 3D, for If merge is not possible the default is Open document.

* If you choose Ask at load time, you can use the load option preference to change how you
want to open files.

Specify open preferences for 2D or 3D files

Some CAD related file types can contain 2D or 3D data. You can set preferences to always open DWG/
DFX, IGES, and PRT files in a 2D Viewing window or a 3D Viewing window. Another option is to be
prompted to choose each time you open a file.

1. Choose File—>Preferences—>File Open.
2. Inthe File Open Preferences dialog box, choose one of the following for each file type:
2D

* 3D
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_ 2. Viewing 2D images and 3D models

* Prompt

Note:

* This functionality is supported in Standard service levels and above. For Base service levels,
these files always open as 2D file types.

* 3D IGES files are supported only in the standalone viewers.

Specify the PLM XML load preferences
1. Choose File=>Preferences->PLM XML.

2. Inthe PLM XML Preferences dialog box, on the Load page, choose from the following
preferences:

Select this To

PLM XML Units Define the unit of measurement. By default, the unit of
measurement for PLM XML and Parasolid files is meters.
You can use the PLM XML Units setting to specify
another unit of measurement.

Note:

e The PLM XML Units setting is saved in session
files. If you change and save the model units
setting with a VF file, the specified model units
of the session file override the current PLM XML
Units setting.

* Session files referencing PLM XML models that
were created prior to Teamcenter lifecycle
visualization 5.1.0.2, do not contain the model
units specification. The software uses the
current PLM XML Units setting on the Load
page of the PLM XML Preferences dialog box
if you load the session file with a newer viewer.
This event may result in content displayed in the
wrong scale. The model units is always meters
for pre-5.1.0.2 PLM XML files.

As a work around, migrate the session file
to a Teamcenter lifecycle visualization 5.1.0.2
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Select this To

version. Load and save the file in Teamcenter
lifecycle visualization 5.1.0.2.

Apply the default product view on Load the default product view when the PLM XML file is
load loaded. If this option is not selected, the default product
view is not loaded but is added as a snapshot, which

(if unchecked, it will be added as a reduces load time.

snapshot)
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3. Working with sessions

Overview of session files

Session files save the state of the viewer so you can resume your work later. Saving your work as a
session file enables you to preserve the following:

Note:

* To use sessions, your system administrator must define ACL (access control list) rules for
Vis_Session using Access Manager. For details, see Configure Teamcenter Lifecycle Visualization
sessions in Teamcenter Visualization Deployment and Administration.

* If a document has been inserted into the session file, the session file becomes a stand-alone
Lifecycle Visualization AppSession and is not interoperable. Stand-alone Lifecycle Visualization
AppSession can be identified in other applications, such as Active Workspace and NX, by the

following icon | S

* Open files

* Inserted 2D and 3D models and documents
* Pruned structures

» Session package

* Snapshot information

* 3D preferences

 Alternate assembly hierarchies

* True Shading settings

* Cross sections

* 3D Measurements

* User Defined coordinate systems
* 3D layers

» Teamcenter revision rules, effectivity, variant rules, active assembly arrangements, and other
configuration settings.
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_ 3. Working with sessions

Example:

You are working with model1.jt, model2.jt, and image.tif. You have created snapshots, changed
background colors, and created markup layers. You then save your work as a .vf session file.

When you re-open the session file, the three files open, and the snapshots, background colors, and
markup layers appear as they were when you saved the session.

Primary and secondary documents

Session files reference primary and secondary documents. A session file can preserve the state of
multiple primary documents, and each primary document may be associated with multiple secondary
documents.

Session file

Primary Primary

document document
3D model 30 model
PLM XML PLM XML

2D image 20 image

Secondary Secondary
documents documents

Markups Markups
Snapshots Snapshots
Inserted model Inserted madel
Motion file Mation file

Static and configured product structure

In terms of session files, product structure is considered to be either static or configured. Static product
structure is a unique version of the document that is created at the time the session is saved. This type
of data ensures that loading the session at a later time will result in the same product structure that
was loaded when the session was first saved. Configured product structure is dynamic and references
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Primary and secondary visualization documents _

Teamcenter configuration settings. This type of data can be thought of as a recipe which can be used
later to get different document revisions.

What is the difference between worksets and session files?

Worksets are a collection of design components that may contain subsets, items, item revisions, BOM
view, and BOM view revisions that represent existing parts or assemblies.

Session files save the state of the viewer so you can resume work on your workset later. Sessions retain
the filters and configurations applied to the structure and may contain worksets, snapshots, and other
documents.

Primary and secondary visualization documents

Visualization files in Teamcenter are always either primary or secondary documents. You can open
primary documents independently from other documents, while secondary documents are dependent
upon primary documents. For example, a JT file is a primary document, which you can view on its own
without any other file having to be open; a markup layer (VPL file), in contrast, cannot be viewed on its
own, and must be opened in the context of a primary document, such as a JT file.

A primary document:
e Can exist in the database on its own.
e Consists of data that has been translated from some master source data such as a CAD file.

» Consists of one file (for example, a 2D image) or a logical set of files (for example, assembly and part
files).

* Can be opened in a Lifecycle Visualization viewer independently of any other documents.

* May have secondary types of documents that depend on it, but may not be aware of these secondary
files.

A secondary document:

Always relies on a primary document.

* Is only meaningful in the context of a primary document (for example, a 3D markup).
* Cannot be viewed in a Lifecycle Visualization viewer without a primary document.

* Is always aware of its primary document.

* May contain many types of data which may serve different purposes (for example, a snapshot consists
of layer data, view data, motion data, thumbnail data, and so forth).
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* May capture additional information about the primary document.

Overview of static and configured product structure

Product structure from Teamcenter is either static or configured. Configured product structure is
dynamically built according to revision rules, effectivity, variant rules, active assembly arrangements,
and other settings, depending on how the structure is initially launched and how the visualization
session is subsequently authored.

Configured structure
The following scenarios result in a configured structure in the viewer:

* From My Teamcenter, launch a BOM view or BOM view revision (or any object that includes a BOM
view or BOM view revision, such as an item or item revision) into the standalone viewer or the
Lifecycle Viewer. The structure is configured in the viewer according to your default revision rule.

* From the standalone viewer, open a BOM view or BOM view revision (or any object that includes a
BOM view or BOM view revision, such as an item or item revision). The structure is configured in the
viewer according to your default revision rule.

* From Structure Manager, Multi-Structure Manager, or Manufacturing Process Planner in the rich client,
launch one or more BOM lines into the standalone viewer or the Lifecycle Viewer. The structure
is configured in the viewer according to whatever configuration is currently active in the launching
application.

Static structure

The following scenarios result in a static structure in the viewer:

* Perform any process that results in opening a PLM XML file in the standalone viewer or the Lifecycle
Viewer. For example, launching a QL file or a DirectModelAssembly dataset results in the loading of a
PLM XML file into the viewer. The viewer treats these data types as static structure, since a session file
authored in the viewer references the static PLM XML.

* Open a VF session file that points to static PLM XML. This occurs under the following conditions:

* The Capture Static Structure check box is selected when the session file is authored.

e The structure in the viewer is saved as PLM XML (File->Save As) before the session is authored.
VF session files and configured or static structures

Opening a session dataset can result in the loading of a static structure or a configured structure,
depending upon the data and the conditions under which the session authored.
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When you save a session referencing configured structure, the session preserves the product structure
configuration active in the viewer. However, if you select the Capture Static Structure check box in the
Session Save As dialog box, the viewer also saves the exact product structure you have open at the
time you save the session. When you load the session later, the viewer detects if this static structure

is available and asks you how you want to open it: as a static structure (the exact product structure

that was active in the viewer at the time the session was saved) or a configured structure (according to
the configuration settings in effect at the time the session was saved). Note that if the Capture Static
Structure check box is not selected when you initially save the session, when you open the session
later the structure is loaded dynamically based on the configuration in effect at the time the session was
saved.

You can set a Teamcenter Integration Preference to automatically handle this when loading a session.
You can choose to:

* Always load the static structure

» Always load the configured structure (the latest version of the structure according to the configuration
settings in effect at the time the session was saved)

e Ask how to load a structure at load time

Session save options

You have a number of options for saving session data to different locations, depending upon whether
the session consists of local data only or includes data from Teamcenter.

If the session includes only data loaded from your local machine, you can save the session file to a
location on your local machine or network.

If the session includes Teamcenter-managed data, you can save the session file to the Teamcenter server
in the following ways:

* Attach to Base Document — Save the session file within the item revision of the primary document.

¢ Attach to Selected Bomline — Save the session file within the item revision of the selected BOM line
in the 3D assembly tree.

» Alternate Location — Save the session file to a different location. Click Browse, and then specify the
folder, item, or item revision within which you want to save the session.

Session files can be saved using either the Vis_session data model or the AppSession data
model. The Vis_session data model supports all features but is not interoperable with other
applications, such as NX and Active Workspace. The AppSession data model has limited feature
support, but is interoperable with the NX and Active Workspace applications. AppSessions that
contain an unsupported feature, such as a multi-document session, appear in other applications

with the following icon ﬂ'm Your administrator can define the TCVIS_APPSESSION_SAVE_DEFAULT
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and TCVIS_SHOW_APPSESSION_SAVE_OPTION environment variables to determine the Session save
behavior for your environment.

Note:

You can use the Teamcenter Integration Session preferences to specify default session save
options.

Save your work session

You can save your work as a .vf session file. When you open the session file later, your work is restored.

Under certain conditions, warning messages display when saving legacy session files (release 12.4 and
earlier). To avoid overwriting the legacy session file, which will cause issues with legacy viewers, on the
warning dialog click Save as and choose a different file location to create a new session file.

Note:

If you want updated layers to be saved as external files, save the layers first using Save All Layers
or Save Selected Layer. If you don't save modified layers before saving the session, the layers
become part of the session file and cannot be loaded independently.

1. Choose File->Save Session.

2. In Session Storage Location, click one of the following.

Use this option To do this

Attach to Base Save the session within the Item Revision of the base document.

Document

Attach to Selected Save the session within the Item Revision of the selected BOM line in

Bomline the 3D assembly tree.

Alternate location Save the session to a different location. Click Browse, and then specify
the folder, Item, or Item Revision within which you want to save the
session.

3. Torename the session file or any secondary documents that you have created during your work
session and not yet saved, such as markup layers, double-click the default name of the document
and type a new name.

Note:

You cannot use any non-ASCIl character (including 8 bit accented Western European and
multi-byte characters) for a file name.
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4. To save the session file in a format that has interoperability between other applications, such as NX
and Active Workspace, select the Save as a collaborative session check box.

This check box is not displayed under the following conditions:

* When saving to a local file path.

* |f the session contains data that is not supported by the AppSession interoperability data
model.

e If the TCVIS_SHOW_APPSESSION_SAVE_OPTION is set to False.

Note:

If a document has been inserted into the session file, the session file becomes a stand-
alone Lifecycle Visualization AppSession and is not interoperable. Stand-alone Lifecycle
Visualization AppSession files can be identified in other applications, such as Active

Workspace and NX, by the following icon | EE.

5. Click Save.

The session file is saved. Any new or unsaved secondary documents are also saved with the session
file to their specified locations.

Note:

* If you have unsaved clearance results, the Save Clearance Results As dialog box appears.
You must save to a .txt file to reference the results in a session file.

* If late loading product views are enabled, and the Vis_PV_LateLoadSaveOp preference is
set to Ask, a dialog box appears in which you must choose how to handle saving partially
loaded product views.

* By default, in a four-tier environment, when you launch stand-alone Lifecycle Visualization
from the Teamcenter rich client, the viewer and the rich client share the same tcserver
session. When you perform stand-alone viewer operations, such as saving a session file,
the rich client may appear to lock up until the viewer operation is finished. If this is
a problem, you can configure Teamcenter to create a separate tcserver session for the
stand-alone viewer.

* Ensure that your administrator has related the Vis Session dataset to the specific item
revision type that you plan to use for sessions. This enables viewing the session saved in
stand-alone Lifecycle Visualization in Teamcenter rich client.

Merge a saved session with an active session

1. Starta new work session or open a session file.
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2. In My Teamcenter, right-click a session dataset and choose Send To-Lifecycle Viewer.

If the sessions can be merged, the Merge Sessions dialog box appears.

3. Click Merge.

The saved session is merged with the contents of the active session.

Specify session preferences

1. Choose File=>Preferences—>Session.

2. Inthe Session Preferences dialog box, change any of the following settings:

In this
section

Session
Merge

Session
Save

Use this
preference

Reuse existing
windows if
possible

Ask at load time

Enable password
protection for
session package

Maintain
dynamic
references when
possible

Show
compatibility
warning

Show legacy
layer resave
warning

Save as
collaborative

To

When opening a session while another session is active, merge
the sessions in the active Viewing window.

Note:

If this option is not turned on, the sessions are opened in
separate Viewing windows.

When attempting to open a session while another session is
active, display the Merge Sessions dialog box, from which you
can specify to merge the session into a single Viewing window.

Apply password protection to .vfz session packages.

When session files are opened, attempt to update linked
references.

When a legacy session is loaded and you select Save Session to
overwrite the original file.

When saving legacy layers independent of a session.

Save session using the collaborative AppSession data model,
which allows session file interoperability between applications
such as NX and Active Workspace.
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In this Use this

section preference To
session when If the features contained in the session file are not supported
available by the AppSession data model, you will receive a session

interoperability warning message.

This checkbox is enabled only when the current contents

can be saved with the AppSession data model and the
TCVIS_SHOW_APPSESSION_SAVE_OPTION environment variable
is not set to False.

3. Click OK.
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4. Working with snapshots and product
views

Introduction to snapshots and product views

Snapshots capture the state of the Viewing window. If you capture snapshots of several views of your
image or model, you can return to any view by applying its snapshot.

You can create the following types of snapshots:
* 2D snapshots

Used to capture the state of the 2D Viewing window when working with 2D images. You can

create and view 2D snapshots in the standalone viewer, the Lifecycle Viewer, Manufacturing Process
Planner, and Multi-Structure Manager. When created in the standalone viewer or the Lifecycle Viewer,
2D snapshots are persisted in session files and PLM XML, or saved to the Teamcenter server as
Vis_Snapshot_2D View_Data datasets. When created in Manufacturing Process Planner or Multi-
Structure Manager, 2D snapshots are saved as Vis_Snapshot_2D View_Data datasets.

* 3D snapshots

Used to capture the state of the 3D Viewing window when working with 3D models. You can create
and view 3D snapshots in the standalone viewer and the Lifecycle Viewer. 3D snapshots are persisted
in session files and PLM XML only.

¢ Product views

Used to capture the state of a 3D scene in Teamcenter. You can create product views in the Lifecycle
Viewer, the standalone application viewer, Manufacturing Process Planner, Multi-Structure Manager,
and Structure Manager. You can open product views in all these viewers. When you create product
views, you save them as a SnapShotViewData dataset.

When you send a product view to the Lifecycle Viewer or open it in the integrated viewer, you can
then modify the product view (modify the existing product view, add a new one, or update the
existing product view) and save it as a dataset in Teamcenter.

Teamcenter product views

Overview of Teamcenter product views

Teamcenter supports opening and modifying product views in Lifecycle Viewer or in the integrated
standalone application viewer. You can also save product views to Teamcenter. Product views include
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views of the assembly or part that may include markups, updates to part color, part repositioning, and
motion 3D snapshots (created using NX).

You can create, modify, and save Teamcenter product views in the following Teamcenter applications:
* Any application that supports the Product View Gallery.

These include Manufacturing Process Planner, Multi-Structure Manager, and Structure Manager.
* My Teamcenter

Currently, product views are always checked out when launched in Teamcenter lifecycle visualization.
This is to prevent multiple users from concurrently editing the product view.

The Vis_PV_CheckOutOnOpen preference controls whether the product views are automatically
checked out when launching them from an application in Teamcenter lifecycle visualization. By default,
the value of the preference is set to True. If the Vis_PV_CheckOutOnOpen preference is set to False:

* The product views are not automatically checked out when launched in the viewer.

* If you want to edit the product view, you must check it out from the launching application before
launching it in the viewer.

* If another user modifies the product view after you open it, they are warned at the time of save and
are not allowed to over-write the new product view to avoid losing the changes made by you.

Working with the Product View Gallery

For Teamcenter applications that support the Product View Gallery, you can send the product view

to the Lifecycle Viewer or to the integrated standalone application viewer. You are given a choice to
open the product view as a static structure or live structure. You can then manage the product view, for
example by adding markups, changing the view, adding new product views, and updating the product
view. You can also right-click in the Snapshot page and select Save as Teamcenter Product View to
create a new snapshot in Teamcenter.

The Product View Gallery is supported by Structure Manager, Multi-Structure Manager, and
Manufacturing Process Planner.

When you work with product views in the Product View Gallery, you can:

* Send one product view from the Product View Gallery to the Lifecycle Viewer or to the integrated
standalone application viewer.

* Send several product views to the Lifecycle Viewer or to the integrated standalone application viewer,
once you have configured the Enable Multiple Select in Product View Gallery.
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* Merge them into the active document or open them in a new viewing window from either the
Teamcenter Attachment panel or the Product View Gallery.

Note:

You can only merge the product views that share the same base structure.

Working with My Teamcenter

You can open, update, and save an existing product view from My Teamcenter in the Lifecycle Viewer or
in the integrated standalone application viewer.

If you save a session, the open product views are converted to 3D snapshots, and saved in the session
without reference to the Teamcenter product view datasets.

Teamcenter product view states

When product views are saved, they capture the following minimum information:

* The static structure capture of the visible occurrences.

* The configuration that was applied to the structure at the time the product view was captured.

* The view state data (for example, markups, cross sections, repositioned component transforms, and
so forth).

* 2D image data (for example, thumbnail, preview images, geometry asset).

You can control how the structure is opened and configured before you apply the viewing data.
You can load and apply product views with three different behaviors:

* As static structure.

When you open the static structure, you open the static capture of the visible product structure at
the time it was saved. The structure is pruned to show only the visible lines at the time of capture.
You can use this product view option when you need to be sure the exact captured 3D scene is
reproduced. You open a product view in a static structure by opening it in the My Teamcenter view
panel, or by sending a product view from My Teamcenter to the Lifecycle Viewer or to the integrated
standalone application viewer and selecting the static structure load option.

* As as-saved structure configuration.

When you open the product view in the as-saved structure configuration, the structure is configured
in the same way it was configured when the product view was captured prior to applying the view.
Since the structure is configured dynamically in this case, there is no way to guarantee this product
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view is identical to what it was when it was captured, because the structure may have changed
since the product view was captured. This allows the product view to be kept up to date as the
structure is updated. You open a product view in the as-saved structure configuration by setting the
Configuration Rules=2update from Product View option when the product view is applied in the
Product View Gallery, or by sending the product view from My Teamcenter to the Lifecycle Viewer or
to the integrated standalone application viewer and selecting the dynamic structure load option.

* As the current structure configuration.

When you open the product structure in the current structure configuration, you open the product
view in accordance to its current configuration set in the Product View Gallery of the launching
program (for example, Structure Manager). You open a product view in a current structure
configuration by setting the Configuration Rules=use current option when the product view is
applied in the Product View Gallery, or by sending the product view from the Product View Gallery
to the Lifecycle Viewer or to the integrated standalone application viewer and then selecting the
dynamic structure load option.

Note:

Parts may appear in incorrect positions when product views authored in the Lifecycle Viewer or
the standalone application viewer are restored in certain Teamcenter embedded viewers. This
problem occurs when the motion system records part transformations on subassembly nodes,
and the transformations are subsequently captured by the product view. These assembly-level
transformations generated by the motion system are not applied correctly when the product view
is restored in Structure Manager, Multi-Structure Manager, and Manufacturing Process Planner.

You can avoid this limitation by keeping 3D part transformations at the part level when working
with motion in the Lifecycle Viewer or the standalone application viewer. Rather than transforming
an entire assembly or subassembly, expand the structure and select all of the individual parts and
move them instead.

Teamcenter product view preferences

You can change several product view and product view related characteristics using Teamcenter product
view preferences. You can access product view preferences by navigating to the Teamcenter Options
menu; choose Edit->Options—>Visualization->Product View.
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Product view preferences are now centralized and changes to these characteristics can also be made
by using Teamcenter preferences. Your site administrator can also set preference protection scope for
product view preferences to USER (the default), GROUP, or SITE.

Note:

If the protection scope is set to GROUP or SITE, preferences are displayed but you may not have
permission to change them.

For more details about setting product view preferences using the Options menu, see Teamcenter
Basics.

For more details about working with product views in Teamcenter, see About product views in
Structure Management on Rich Client —Usage.

Teamcenter product view toggle states

Using Teamcenter, you can set product view options to show or hide unconfigured objects by selecting
or clearing view toggle states. When you send the product view to the viewer, these unconfigured
objects are shown or hidden as they were shown or hidden when the product view was captured. You
can set view toggle state preferences in Teamcenter by navigating to Edit>Options—->Product View.
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The captured product views may result in active view toggles that generate non-buildable assembly
configurations. To control the creation of non-buildable product views, your administrator may prevent
generating product views when certain unconfigured objects exist. In addition to preventing the
creation of toggle view states, the administrator can also choose to warn or process product views

which contain unconfigured data.

If you choose to update the configuration from the product view when you reopen it, the saved view
selections are retrieved; if you choose to use the current configuration, the saved view selections are
ignored.
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The administrator can set preferences to determine how product views are created when unconfigured
objects are shown. The administrators options include the following:

» Off

* Warning
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Note:

In the Invalid assembly state dialog box that appears, a message indicates that active view
toggle states were detected. You can then choose to proceed with product view creation or
modification or you can cancel the task.

¢ Prevent

Note:

In the Invalid assembly state dialog box that appears, a message indicates that active view
toggles were detected. You are asked to turn off active toggles in order to proceed with product
view creation or modification.

Caution:

You use the view toggle Show Suppressed Occurrences to see BOM lines that are suppressed

in the current assembly arrangement in Structure Manager. If you send an assembly to the
standalone application viewer or the Lifecycle Viewer when this view toggle is on, the suppressed
structure elements are grayed out. An inactive structure warning appears when you open

a product view that contains suppressed occurrences. This can be avoided if you choose

the appropriate View Toggle Warning Level for product view creation and then select Show
Suppressed Occurrences from Edit—->Options—->Product View.

For more details about working with view toggle states in Teamcenter, see Manage unconfigured data in
a product view in Manufacturing Process Planner.

Late loading Teamcenter product views

You can enable late loading of Teamcenter product views, by using the Vis_PV_AllowLateLoading
preference. Late loading is useful to reduce the time it takes to load a large number of product views
at once in standalone Lifecycle Visualization. A late loaded product view appears as a thumbnail on the
3D Snapshots page, but the entire product view is not loaded until you fully open the product view by
applying the 3D snapshot.

When late loading is enabled, you can set how partially loaded product views are handled when you
save a session file or a .pImxml file. You do this by setting the Vis_PV_LateLoadSaveOp preference with
one of these values:

* Abort
When late loaded product views are detected, the save operation is aborted.
* Ignore

The file is saved, but partially loaded product views are not included.
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¢ LoadAll (default)
All partially loaded product views are loaded and saved.
* Ask

When you save a session file or a .plmxml file and late loaded product views are present, a dialog box
appears and provides these options:

* Save the file but ignore partially loaded product views.
* Load all partially loaded product views and save the file.

* Abort the save operation by clicking Cancel.
Opening Teamcenter product views

Overview of opening Teamcenter product views

You create product views in Teamcenter using the Product View Gallery. Product views can then be
sent to the Lifecycle Viewer or to the integrated standalone application viewer.

Note:

Product and manufacturing information (PMI) may not appear in a viewer if the model was saved
in a Teamcenter product view and then the dimension of the object was changed in a CAD
program in a way that changed the PMI. When this occurs, the caption PMI Missing appears

for any PMI that cannot be restored. (The text of this caption may differ depending on how the
caption is defined on the Snapshots tab in the PMI Preferences dialog box.) Also, you may need
to zoom out to see the caption.

You can:

¢ Open product views from the Product View Gallery or Attachment panel. The current
configuration of the structure in the launching program is loaded in the viewer when you apply
the product view.

* Open product views from My Teamcenter. You are given the option to open the product view as a
static structure or dynamic structure.

* If you elect to open the product view as a static structure, the exact structure that was saved with
the product view is reloaded and applied.

* If you select to open the product view as a dynamic structure, the as-saved configuration of the
structure when last saved is applied when the product view is applied.
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* Open an NX motion product view. In this case, you open a product view that contains motion and
that was authored by NX.

Note:

You can enable late loading of product views, by using the Vis_PV_AllowLateLoading preference.
Late loading is useful to reduce the time it takes to load a large number of product views at once
in standalone Lifecycle Visualization. A late loaded product view appears as a thumbnail on the 3D
Snapshots page, but the entire product view is not loaded until you fully open the product view by
applying the 3D snapshot.

Open product views from the Product View Gallery or Attachment panel

You can open product views from a Teamcenter application that supports the Product View Gallery and
open them in the Lifecycle Viewer or in the integrated standalone application viewer. You can also open
product views from the Teamcenter Attachment panel.

You are given a choice to open the product view in a live structure (dynamic) or in an as-saved
configuration (static).

Teamcenter applications that support the Product View Gallery include Structure Manager, Multi-
Structure Manager, or Manufacturing Process Planner.

1. From Structure Manager, Multi-Structure Manager, or Manufacturing Process Planner, do one of the
following:

¢ Choose View=>Show/Hide Data Panel.
* On the toolbar, click Show/Hide Data Panel | "|.

2. Click the Viewer tab.

3. If Create 3D Product Views toolbar is not visible, right-click in the viewer menu bar and choose
Create Markup.

Teamcenter displays the Create Markup toolbar.
4. On the Create Markup toolbar, select Create 3D Product Views @

Teamcenter displays the Product View Gallery window, which contains thumbnails of any
previously saved product views that are associated with the selected object.
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& Product View Gallery @
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5. Right-click any product view thumbnail and select one of the following:
* Send to Lifecycle Viewer
* Open in Teamcenter Visualization
6. To configure the software to open more than one product view at a time, do the following:
Open the Product View Gallery.
Right-click in the lower portion of the Product View Gallery dialog box, for example near Cancel.
Click Options and then select Enable Multiple Selection.
Press Ctrl and click each product view you want to open in the viewer.

In the 3D Load Options dialog box that appears, select Open in a new window or Merge into
active window.

Note:

* The option to merge is only available if the new 3D product view shares a base
structure with the document that is already open.

* If you selected Merge into active window, you are asked once again to confirm
the merge. Additional product structure occurrences automatically open in the active
window.
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* If you open product views from the same assembly one at a time, the 3D Load
Options dialog box appears giving you the choice to open each product view in a
new window or to merge it into the active window.

7.  (Optional) From the Attachments panel do one of the following:
* Right-click a product view and select Send To->Lifecycle Viewer.
The product view opens in the Lifecycle Viewer.
* Select the product view and then choose File=>Open.
Open product views from My Teamcenter

You can send existing product view datasets from My Teamcenter to the Lifecycle Viewer and the
integrated standalone application viewer.

1.  Select the 3D product view that you want to open.

2. Do one of the following:

To Do this

Send the product view to the Right-click the product view and select Send To->Lifecycle
Lifecycle Viewer Viewer.

Send the product view to Highlight the product view and do one of the following:
the integrated standalone

application viewer * Choose File=»Open In Lifecycle Visualization.

* On the main toolbar, click Open/Start in Lifecycle
Visualization%ﬁ .

3. If the Product Structure dialog box appears, select one of the following:

Select this option To

Configured structure Load the latest configured structure based on the as-saved configuration
settings when the product view was last saved and apply the product
view. Configured product structure is dynamic.

Static structure Load the original static structure captured when the product view was
last saved and apply the product view. This option makes sure the exact
3D scene is recreated.
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Opening NX motion product views

You use NX to create product views that contain motion. After you save the motion product view into
Teamcenter, you can open the product view in the Lifecycle Viewer or in the integrated standalone
application viewer. You can play motion files forward or backward, jump to a specific frame, fast forward,
rewind, and repeat the animation.

Note:

You cannot save a motion product view to Teamcenter from the Lifecycle Viewer or in the
integrated standalone application viewer. You cannot update a product view that was saved by
NX to preserve the interoperability with NX. You can, however, create a new product view after
you open a motion product view.

Create a new product view

1. From a Teamcenter application that supports the Product View Gallery, create a view you want to
capture in the Viewer window.

2. Onthe Create Markup toolbar, select Create 3D Product Views @

Teamcenter displays the Product View Gallery window, which contains thumbnails of any
previously saved product views that are associated with the selected object.

& Product View Gallery @
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3. Click Create a new snapshot =I.

Add a product view

You can create a product view on a structure that you opened in the Lifecycle Viewer or in the integrated
standalone application viewer. You can also update or create a new product view from an existing
product view as long as you opened it as a dynamic structure.




Update or replace a product view _

1. Send a dynamic structure to the Lifecycle Viewer or the integrated standalone application viewer,
or send a product view and open it with dynamic structure.

2. From the viewer, adjust the orientation, add a markup, or make changes to the view of the model.

3.  Onthe Snapshots page, right-click and select Add.

Cycle

Add
Insert

Delete
Replace

Update

Apply 3
Select »
Recapture Image

Rename...

Dizabled

References...
Save as Teamcenter Product View

Toggle View

Preferences...

The new product view appears on the Snapshots page.

4. Select Save as Teamcenter Product View.
Update or replace a product view

You can update or replace an existing product view that you have opened in the Lifecycle Viewer or in
the integrated standalone application viewer.

There are situations where product views cannot be updated or replaced, including the following:
* NX-generated Teamcenter product views, including all product views with motion.

* Non NX-generated Teamcenter product views where a 3D document has been inserted into the
resulting view.

» Teamcenter product views that are checked out by another application or user.
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» Teamcenter product views that are already opened by this viewer (for example, load the same
snapshot a second time by either merging it into the same view or opening it in a new view in
the same viewer).

1. Send an existing product view to the Lifecycle Viewer or in the integrated standalone application
viewer and open it as a dynamic structure.

2. From the viewer, adjust the orientation, add a markup, or make changes to the view of the model.

3. Inthe Snapshots page, right-click the product view and select Update or Replace.

Note:

Using Replace is similar to deleting and recapturing a snapshot. The 3D elements captured in
the snapshot reflect the current Snapshot Preferences.

Using Replace also recaptures the thumbnail image displayed in the Snapshots view. The
name of the snapshot is retained.

Cycle

Add
Inzert

Delete

Replace

Update

Apply 3
Select b
Recapture Image

Rename...

Dizabled

References...
Save as Teamcenter Product View

Toggle View

Preferences...

Note:

Using Update recaptures the 3D elements that are present in the snapshot. For 3D content
to be updated, the appropriate preferences must be active in the Snapshot Preferences. Only
preexisting 3D elements within the snapshot are modified. 3D elements not enabled in the
preferences when the snapshot was initially generated are not created.




Save product views to Teamcenter

window Snapshots view.

Save product views to Teamcenter _

Using Update also recaptures the thumbnail image displayed in the Project Workspace ‘

Cycle

Add
Insert
Delete
Replace

Update

Apply 3
Select »

Recapture Image
Rename...
Disabled

References...
Save as Teamcenter Product View

Toggle View

Preferences...

You can update or save new dynamic product views to Teamcenter. The product view is saved as a
SnapshotViewData dataset. You select the BOM line in the product structure for the location to attach
the saved product view to. If you do not select a BOM line, the top node in the product structure is
automatically used.

There are situations where product views cannot be created so the Save as Teamcenter Product View
and Send View to Structure Manager options are disabled. You cannot create a product view in the
following situations:

It is a single JT part from Teamcenter.

It is a local 3D part or assembly.

It is an NX-generated product view from Teamcenter.

A PLM XML from Teamcenter.

It is an assembly from a server with Teamcenter 8.3 or earlier.
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* If you load a dynamic assembly from Teamcenter and insert another unrelated assembly or part.

* A 2D image.

Note:

Saving a product view from Lifecycle Visualization to Teamcenter when the product is displayed
in Massive Model Visualization (MMV) mode may take additional time to complete. This is due to
the potential need to expand portions of the product structure. When product structure is loaded
in MMV mode, the occurrence paths of the visible parts are not fully expanded. Due to the data
model used by Teamcenter product views, the application must expand the occurrence path to all
visible parts.

To save a single product view:

1.

2.

3.

4.

Load a configured structure in the viewer or load an existing product view.
Create a new product view, add an additional product view, or update an existing product view.

On the Snapshots page, right-click and select Save as Teamcenter Product View.

Cycle

Add
Insert
Delete
Replace

Update

Apply k
Select [
Recapture Image

Rename...

Dh=abled

References...

Save as Teamcenter Product View

Toggle View

Preferences...

Do one of the following in the New Teamcenter Product View Dataset dialog box:

* Accept the system name for the product view by clicking OK.

4-16




Save several product views to Teamcenter _

* Type in a name in Enter name for new Product View dataset and then click OK.

F =

Mew Teamcenter Product View Dataset @

Enter name for new Product View dataset

20110321-102640

Cancel

Save several product views to Teamcenter

You create several different product views and you want to save them back to Teamcenter in the exact
viewing state they were created in. Use the following steps to save several product views.

1. Load a configured structure in the viewer or load an existing product view.
2. Create more than one product views.
3. On the Snapshots page, highlight the first product view, then double-click.

4.  Onthe Snapshots page, right-click and select Save as Teamcenter Product View.

Cycle

Add
Insert
Delete
Replace

Update

Apply 3
Select k

Recapture Image
Rename...
Disabled

References...

Save as Teamcenter Product View

Toggle View

Preferences...
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5. Repeat Step 4 for each product view that you want to save in the initial viewing state.

Example:

You open data and create three product views. The first is a circle, the second is a square, and the
third is a triangle.

If you highlight the first product view, right-click and select Save as Teamcenter Product View,
you will save the product view with the triangle (the current view) when you expected to save the
product view with the circle.

If you highlight the first product view, double-click, and then right-click and select Save as
Teamcenter Product View, you save the product view with the circle.

Highlight the product view with the square, double-click, and then right-click and select Save as
Teamcenter Product View, you save the product view with the square.

Capturing images and creating 3D geometry assets

Overview of capturing images and creating 3D geometry assets

You may find it useful to capture an image of your product view when working with various issues
encountered in the design and manufacturing process. For publishing, creating 3D geometry assets of
the product view may be beneficial. A 3D geometry asset is data that is included in illustrations and
publishing. You must have Visio in order to work with 3D geometry assets.

The appearance of the captured image and 3D geometry assets is determined by you and by your site
administrator. Your site administrator controls whether or not these options are available.

If these features are made available by the administrator, you can set preferences for them using the
Snapshot tab of the Teamcenter Integration Preferences dialog box.

Create product view 3D geometry assets

You can save 3D geometry assets in the Teamcenter product view dataset if 3D geometry assets are
available in your environment.

Note:

Creating 3D geometry assets is only supported on Windows.

1. Choose File>Preferences>Teamcenter Integration Preferences.

2. From the Snapshot tab of the Teamcenter Integration Preferences dialog box, select the Add or
Update 3D Geometry Asset check box.
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Capture an image of a product view _

3. (Optional) Select the Draw Outline check box if you also want to save an outline capture in the
Teamcenter product view dataset.

Tip:

One way to verify the saved 3D geometry asset is to use the Teamcenter Named References
dialog box.

a. Highlight the saved product view in My Teamcenter, right-click and select Named
References.

b.  Highlight 3DGeoAsset and click Download. Choose the name and location on your local file
system to save the file.

c.  Open the saved .asset file in Visio.

ﬁﬁ Mamed References @
‘g:: ﬂ.
Reference Marme Size Remuote Type Last Medif... Veolume
RootContet |wisSC_20110... Visstructure...|20-Mar-201...

Thumbnaill... thurmbnaill... 3273 bytes [manFile 20-Mar-201... [volumel
AiewFile yiewlata 2 11 Kb ImanFile 20-Mar- 201 Jvolumel
[3DGeohsset [geomAsset... 117 Kb ImanFile  [20-Mar-201... jvolumel |
lmage imagelapt... 25 Kb lmankile £U-Mar-£UL... [volumel
3DMarkup  |Layerl.vpl 16 Kb [manFile 20-Mar-201... [volumel
CS5tructure... |PY_struct_fi... 3586 bytes ImanfFile 20-Mar-201... volumel

Open ] [ Upload... ] | Download.., X Ry i b

Capture an image of a product view

You can save captured images in the Teamcenter dataset If image capture is available in your
environment.

1. Choose File=Preferences-»Teamcenter Integration Preferences.

2. From the Snapshot tab of the Teamcenter Integration Preferences dialog box, select the Image
Capture check box.

3. (Optional) Select the Use Image Export Dialog check box if you want the Export Image dialog
box to appear. You can use this dialog box to change the resolution, file type, or color mode of the
image capture.
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Export Image it
Exportimage Watermark
Input Image
Width Height: Units: Resolution:
44733 x 3.0267 inches 150 dpi
Cutput
Export |Image V
Width: Height: Units: Resolution:
44734 X 3.0267 inches v 150 | dpi
- [ ]Retain dpi
Ratio to Original Image: 100.0011 -~ |
File Format
Color Mode: | Color v
Type: | png o
OK Cancel

Tip:
One way to verify the saved image capture is to use the Teamcenter Named References dialog
box.

a. Highlight the saved product view in My Teamcenter, right-click and select Named
References.

b.  Highlight Image and click Download. Choose the name and location on your local file system
to save the file.
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c.  Open the saved file.
Q Mamed References @
£ ®
Reference  Mame Size Remnote Type Last Modif... Velume
RootContest |wisSC_20110... VisStructure...|20-Mar-201...
Thumbnaill... thumbnaill... 3273 bytes [manFile 20-Mar-201... [volumel
ViewFile viewData_2... 11 Eb ImanFile 20-Mar-201... volumel
ADGeohsset |geomAsset., 117 Kb ImanFile 20-Mar-201,,, Ivolumel
[Image imageCapt... 39 Kb [manFile 20-Mar-201... [volumel |
sDMarkup  |Layerl.vpl 16 Kb lmankile 20-Mar-201... [volumel
CSStructure... |PY_struct_fi... 3586 bytes ImanFile 20-Mar-201... volumel
’ Open ] [ Upload... ] | Download.., ;.-.,; rt] i ad

Product view system constraints and preferences

You or your site administrator can use system constraints and site preferences to control the appearance
and behavior of thumbnails, image captures, and 3D geometry assets.

Site preferences control the following behaviors.

Thumbnail * Vis_PV_ThumbnailWidth

* Vis_PV_ThumbnailHeight

* Vis_PV_thumbnailQuality
Image Capture * Vis_PV_ImageCaptureWidth

* Vis_PV_ImageCaptureHeight
* Vis_PV_ImageCaptureType

* Vis_PV_ImageCaptureResolution

3D Geometry Asset ¢ Vis_PV_capture3DGeomAssetAsOuline
System constraints control the following behaviors.

Image Capture The FndOVisPVImageCapture constraint determines if Image Capture is available.

Valid values:
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+ OffNoMenus
¢ OnNoMenus

* OnWithMenus

3D Geometry The FndOVisPVGeoAsset constraint determines if saving 3D geometry assets is
Asset available.

Valid values:
+ OffNoMenus
¢ OnNoMenus

¢ OnWithMenus

Using 2D snapshots in Teamcenter

Overview of using 2D snapshots in Teamcenter

Teamcenter supports creating and saving several 2D snapshots over time so you can track and review
changes that have been made. For example, you may want to compare various components of a design
today with changes made during the manufacturing lifecycle. Teamcenter supports tracking these
changes with the 2D Compare option, which is a tool supported by several Teamcenter applications
including Manufacturing Process Planner and Multi-Structure Manager. These applications also support
the Snapshot Gallery, and snapshots must be stored in this gallery before you can use 2D Compare.

You can send either an item revision (base document) or a previously saved snapshot (derived data)
from Teamcenter to the Lifecycle Viewer. You can also open an item revision or previously saved
snapshot in the Lifecycle Visualization viewer when it is integrated with Teamcenter. If the matching
base document is not open, the viewer opens the base document and inserts the snapshot. The viewer
immediately applies the snapshot layer to the view. When the base document is open, you may be
prompted to open this document in a new window or insert it into the existing view. Teamcenter
supports sending item revision and snapshot data from My Teamcenter or from the Snapshot Gallery.

Once the Teamcenter item revision or previously saved snapshot is displayed in the viewer, you add
markups and then create a snapshot of a specific area of the image. You save the snapshot in
Teamcenter, and it is associated with the Teamcenter item revision.

While you can send 2D snapshot item revisions from Teamcenter applications such as My Teamcenter,
Manufacturing Process Planner, and Multi-Structure Manager, snapshots must be in the Snapshot
Gallery to use 2D Compare tools.
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Send Teamcenter 2D snapshots to the viewer

1. In My Teamcenter, do one of the following:
To send a Teamcenter 2D snapshot to Do this
The Lifecycle Viewer Right-click the Teamcenter 2D snapshot or item
revision and click Send To->Lifecycle Viewer.
A standalone viewer Select a Teamcenter 2D snapshot or an item

revision and do one of the following:

* On the My Teamcenter toolbar, click Start/
Open in Lifecycle Visualization .

* Choose File=Open in Lifecycle
Visualization.

The viewer opens. If Ask at load time is turned on in the 2D Load Options, the Load Option
dialog box is displayed.

Note:

If the Load Option dialog box is not displayed, the dataset is loaded according to the current
Load Options settings.

2. (If the 2D Load Options dialog box is displayed) Click one of the following options:

Use this option To do this

Open document Do one of the following:
* Open the document in a new window.

* (If the document is already open in a
window) display the window.

Insert document into active window Insert the document into the currently active
window.
Open with markups Open markups associated with the dataset.
Note:

Markup layers appear in the 2D assembly
as snapshot layers. The snapshot layer
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Use this option To do this

is locked so you can review changes to
future snapshots.

Don't show this dialog again Always use the current settings without
displaying the 2D Load Options dialog box.

You can also send 2D snapshots from the Snapshot Gallery.

Create Teamcenter 2D snapshots using an item revision
1. Select an item revision and send it to a viewer.
2. Create a 2D markup on the base image.
3. Zoom into the image or pan the image and do one of the following:
* In the Snapshots view, right-click and choose Add.

* On the Snapshots toolbar, click Add .

Your snapshot is added to the Snapshots view.

Note:

The snapshot or snapshots that you created support features associated with standard
2D snapshot options. For example, these options include adding, inserting, deleting, and
naming snapshots.

When you save the image as a Teamcenter snapshot, the snapshot is locked and cannot be
edited.

Save Teamcenter 2D snapshots

1. Display the item revision that includes a base image in a viewer and add both a markup and
snapshot.

The snapshot is displayed in the Snapshots view.
2. Right-click anywhere in the Snapshots view and select Save as Teamcenter Snapshot.

The snapshot is saved to your Teamcenter server. The border is now wider than a non-Teamcenter
snapshot and the snapshot is automatically named.
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Note:

¢ The Teamcenter snapshot cannot be edited and all shortcut menu options are unavailable
except for Add.

* Because the snapshot is locked, you can create future snapshots to display changes to the
design.

3. (Optional) If prompted, complete the revision, page, and custom attribute values in the Form Data
dialog box.

The Revision and Page values are auto-filled. Add appropriate custom data, as needed.

Note:

Optionally, you can save the Teamcenter item revision and snapshot as a session. The session
contains all data associated with this session and saves it as one file. When you open the session
later, your work is restored.

How do I track design changes using Teamcenter 2D snapshots?

In the following example, the 2D image of a garage door assembly is used. The image is shipped with
Teamcenter and is saved in the 2D example folder.
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g 4257

Create markup layer
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Note:

This example describes how you create and save a Teamcenter snapshot, and it includes opening
the item revision in Lifecycle Visualization, adding a markup, and adding a snapshot of the image.
The final step is to save the snapshot back to Teamcenter.

To realize the full benefit of comparing snapshots, use Teamcenter applications such as
Manufacturing Process Planner and Multi-Structure Manager because these applications
include storing snapshots in the Snapshot Gallery. When snapshots are stored in the Snapshot
Gallery, the 2D Compare feature is available.

From My Teamcenter, highlight an item revision.
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Choose File=Open In Lifecycle Visualization.

Create a 2D markup.
In this example, a text markup is added to the image.
Zoom and pan the image until you are satisfied with the section for your snapshot.

In this example, the area of focus is the part displayed in the following graphic.

J

2 000239/ ;1-door M=
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OB aze Document
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Note:

Because the snapshot layer locks the image, the image cannot be modified. Future snapshots
can then be compared to this image.

From the Snapshots toolbar, select Add.

From the Snapshots view, right-click and choose Save as a Teamcenter Snapshot.
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When the snapshot is saved to Teamcenter, the snapshot border is wider than non-Teamcenter
snapshots. This feature makes it easier to identify both Teamcenter and non-Teamcenter snapshots.
Also, the snapshot is automatically given a name. You can view the name by moving your cursor
over the snapshot.

A

000233441 -door

L Azgembly E Snapzhots

Note:
» Before you save the snapshot to Teamcenter, notice that all shortcut menu options are
available.

* When you save the snapshot to Teamcenter, all shortcut menu options are unavailable
except for Add and the name of the snapshot.

000239/ 8; 1-door add
Insert

Add Delete
Replace

Recapture Image
Mame, .,

Save as Teamcenter Snapshok, .,
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Visualization

View partitions in Lifecycle Visualization

A partition scheme logically organizes sets of design components into a hierarchy of partitions and
contains attributes that specify the characteristics of a collection of partitions.

When you view 4GD worksets, you can choose the partition schemes to apply per subset. For
information about partitions, see Learn about partitions in 4G Design Management — Deployment
and Rich Client Usage in the Teamcenter Help.

When you open and display a BOM view revision (BVR) structure in the standalone application viewer
or the Lifecycle Viewer, the root node of the structure may have partition schemes that reorganize the
structure based on function (for example, electrical) or on a specific use case.

For a given BVR structure with partition schemes, to choose the partition scheme to display, right-click
the root node of the structure (model) and choose Partitions - Partition Scheme - the partition
scheme you desire.
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Degrees of Freedom
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Partitions > | Show assembly structure |
Partition Scheme ¥ [Mone]
I FirstSchemeEmpty
PopulatedScheme

When you expand a BVR structure or make certain parts visible, parts (or subassemblies) that are not
assigned to any partition in the active partition scheme are displayed under Unassigned and Loaded.
This means that you have not loaded the entire structure to view everything that was unassigned, but
loaded the structure that was not assigned to any partition.

=EHEModels
EETE4014435/A:1-BVRPST Chassis
52’ Unassigned and Loaded
85l 7 PTNO00O016/001;1-Child and Parent Both Members of Partition
8BLEF PTNOOOO17/001;1-Partitions with Multiple Parents
88L.EF PTNOO0020,/001;1-Partitions with Packed Siblings
86 ¥ PTNOOOO13/001;1-Members of Multiple Partitions
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Partitions as design component containers _

Note:

If you do not see the unassigned partition, either the structure does not contain any, or you have
yet to load any parts that are not assigned to a partition in the active partition scheme.

Partitions as design component containers

Partitions are optional organizational containers for design components and may be empty. Design
components may be members of one or more partitions or no partition.

* You highlight partitions to select all the design components they contain.

Partitions are not selectable occurrences that define the position of design components. When you
click a partition line in the assembly tree, the partition line is highlighted (light blue) but not selected.
However, all the child design components the partition contains are selected (dark blue).

=S Models
[=-BHE 7] Ship_Workset/a, 1
=+ (5 [ Ship_CDS

=+ 8| M Syskems S1_BAD0T 1 -Systems 51 R
- 8e. T Cooling 51_B/001;1-Conling
— e, [ Electrical 51_B/001:1-Electrical
— el Exhaust 51_B/0071:1-Exhaust
—EELD Generator 51_BA007:1- Generakar
ELI:l Detailed _Frame 51_B/001 1 -Detailed _Frame
=8 [ LTCE5351274_a_1/0011-LTCS5351274 _A_1
FAM|LTC55351275 4 1001:1-LTC55351275 4 1
FAM|LTC 76_A1A0011-LTCS f
& 8T LTC55342019_A_1/001 1-LTCS5342019_4_1
i+ 8e[, [ Concept_Frame 51_BA001:1-Concept_Frame

=)

* Some design components are unassigned.

Unassigned design components are part of the subset definition but are not a member of any
partition in the subset's active partition scheme. Unassigned design components are all grouped
under a pseudo partition named Unassigned in the assembly tree.

S Models
IJ;'l-E"[EDShlp workset!s ]
=+ 5 [ Ship_CDS
ELI:l S';.-'stems 51 BA0OT A -Systems S1_B
| | Cooling b 11':l:ll:lllr'lg

I ELD Unassighed
101 1-Exhaust

ELI:l Detailed Frame 51_B/0011-Detailed_Frame
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_ 5. Working with partitions in Lifecycle Visualization

In case of a BOM view revision (BVR) structure, unassigned design components are all grouped under
Unassigned and Loaded. This type of partition is represented in the assembly tree with a grayed out
partition icon.

Partitions may be empty.
Empty partitions contain no design components, although they may contain other empty partitions.

=S Models

[=-BHE 7] Ship_Workset/a, 1

=+ () [ Ship_CD5

EELI:I Systems 51_B/007 1 -Syskems 51_B

26l [T Cooling 51 B/001 1 -Cooling
oo D Electrical 51 BA0011-Electrical |
og D Exhaust 51_BA001:1-Exhaust
oo D zenerator 51 B40011-Generator |

By default, empty partitions are not shown in the assembly tree. You can set a preference to show
empty partitions, which is effective for all for subsequently loaded documents. If shown, empty
partitions are identified in the assembly tree with a gray filled visibility control check box, as they
contain nothing to display.

1. Choose File—>Preferences—>Teamcenter Integration.

2. Click the 3D Loader tab.

3. Inthe Partitions section, select the Show empty partitions check box.

View properties of partitions

Display the properties of a partition to view information that is included in the file about the attributes of
the partition.

Right-click the partition node in the assembly tree, and choose Properties.
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Properties *
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Date Modffied: 2018/07/2708:47:15
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Date Released: 1/01/01-00:00:00

Defining Objects:

Delimiter:
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Diagram Foot Relation:

Diagram Snapshot:

Diagram Template Relation:

Digital Signature Audit Logs: v

Plimb ] T ks s b 1

£ >
Find... Add As Column Prirt Export Ta File

Corcs

Set partition schemes for subsets or subassemblies in Lifecycle
Visualization

Partition schemes contain attributes that specify the characteristics of a collection of partitions. When
you view 4GD worksets or BOM view revision (BVR) structures, you can choose the partition schemes
to apply for each subset or subassembly. You set the partition scheme to be applied to all subsets or
subassemblies, and you can apply partition schemes to individual subsets or subassembly.

* Apply default partition schemes to all subsets

You can set a preference to apply active partition schemes to all subsets or subassemblies, for the
opened document and any subsequently loaded documents. Active partition schemes are the default
schemes set on subsets or subassemblies in the Subset Defaults attribute group under Viewed
Partition Scheme in Teamcenter. For subsets or subassemblies that do not have an active partition
scheme defined, no partitions are shown when the subsets or subassemblies are loaded.
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_ 5. Working with partitions in Lifecycle Visualization

Note:

If you select this preference, the partition scheme setting for all subsets or subassemblies is
overwritten. Any partition schemes you have selected on individual subsets or subassemblies
are cleared and the subset or subassembly reverts to showing its active or default partition
scheme, or no partition scheme if an active partition scheme is not defined for a subset or
subassembly.

1. Inthe Assembly view, right-click an empty area and choose Preferences.
2. Inthe Assembly Preferences dialog box, select Show active partition scheme in 4GD.
3. Click OK.
* Select partition schemes for selected subsets
You can set partition schemes on individual subsets.
1. (Optional) Hold Ctrl and select multiple subsets.
2. Right-click the subsets or subassemblies for which you want to set the partition scheme.

3. Choose Partitions—>Partition Scheme-the partition scheme from the list. The currently active
partition scheme is disabled in the list. If you do not wish to apply a partition scheme, choose
None.
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6. Sending 4GD worksets to Lifecycle
Visualization

4GD Lifecycle Visualization overview

You can launch 4GD worksets into standalone Lifecycle Visualization or the Lifecycle Viewer for viewing
and analysis. This gives you the ability to conduct design reviews using visualization features unavailable
in the 3D viewer embedded in 4G Designer, including session files and session packages. A session file
enables you to save the state of your work; when you open the session file later, your work is restored.
Session packages allow you to move your work to another location.

You can display visualization data associated with 4GD worksets as a flat list of design components or in
the context of their hierarchy.

Subsets may have an active/viewed partition scheme, which logically organizes sets of design
components into a hierarchy. When you view 4GD worksets, you can interactively set the partition
scheme to view per subset.

Launch worksets into Lifecycle Visualization

You can launch 4GD worksets into the standalone application viewer or the embedded Lifecycle Viewer.

Note:

Lifecycle Visualization supports viewing configured worksets only. You cannot open other 4GD
objects, such as individual design components or subsets.

1.  Set the load option preferences for 3D files.

Note:

You can specify to open 4GD worksets as new documents or to insert worksets into the active
Viewing window as a new model in the assembly tree. You cannot merge 4GD worksets in
Lifecycle Visualization.

2. Specify how to load any subsets contained within the workset.

3. Tosend 4GD worksets into standalone Lifecycle Visualization from My Teamcenter or 4GD Designer,
do any of the following:

* Right-click a workset and choose Start/Open in Teamcenter Visualization.
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_ 6. Sending 4GD worksets to Lifecycle Visualization

* On the My Teamcenter toolbar, click Start/Open In Lifecycle Visualization .

* On the 4GD Designer Content Explorer toolbar, click Start/Open In Lifecycle Visualization .

Note:

By default, these options are hidden, but you can show the user interface for sending data
into the standalone application viewer.

4. To send 4GD worksets into the Lifecycle Viewer from My Teamcenter or 4GD Designer, right-click a
workset, point to Send To, and select Lifecycle Viewer.

Replay subset recipes when loading worksets

You can specify to replay subset recipes when loading worksets into Lifecycle Visualization.

1. Inthe standalone application viewer or the Lifecycle Viewer, choose
File->Preferences>Teamcenter Integration.

2. Onthe 3D Loader tab of the Teamcenter Integration Preferences dialog box, in the Product
Structure section, select Configure an updated structure.

3. From the Update Subset on load list, select one of the following:
* No Update
Use this option if you want to load subsets without replaying the subset recipes.
* Replay Recipe

Use this option if you want to replay subset recipes before loading the data. This ensures that
you obtain the latest data.

4. Click OK.

Note:

When you update this preference, the changes are applicable only for data subsequently
launched into Lifecycle Visualization. There is no effect on worksets currently open in the
viewer.
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Display presented parents in Lifecycle Visualization _

Display presented parents in Lifecycle Visualization

You can display visualization data assigned to partitions in 4GD worksets or BOM view revision (BVR)
structures as a flat list of members under the partition or in the context of the presented parent
hierarchy.

1. Inthe standalone application viewer or the Lifecycle Viewer, open and display a 4GD workset or a
BVR structure containing partitions.

EFEHEMeodels
5 B [ 000028/ A:1-Workset-1
=+ ) [ Subset-1
E J [ DE002402,/001:1-331-55045 1
J [ DE002403/001:1-331-55405 1

2. Do one of the following:

* Display presented parents for all subsets:
a. Inthe Assembly view, right-click an empty area and choose Preferences.
b. Inthe Assembly Preferences dialog box, select the Show assembly structure check box.
c.  Click OK.

» Display presented parents for selected subsets:
a. (Optional) Hold Ctrl and select multiple subsets.
b.  Right-click the subsets (or subassemblies) for which you want to display presented parents.
c.  Choose Partitions>Show assembly structure.

3. Inthe assembly tree, expand the presented parents to reveal nodes for the design component
members of the subset or subassembly. Presented parents that are not members of the subset are
represented by a ™, icon, while presented parents that are members of the subset are represented
by a 4, icon.

B Models
=B [P 000028/ A1 -Workset-1
=) [ Subset-1
™, W DE002284/001; 1-Connections, Shocks
5 B, [ DE002285/001:1-482-10267 4
= 8 [ DE002306/001:1-335-10710 1
t | [ DEO02402/001;1-331-55045 1
| [ DEO02403/001;1-331-55405 1

6-3



_ 6. Sending 4GD worksets to Lifecycle Visualization

Save a session referencing workset data

When you work with 4GD worksets in standalone Lifecycle Visualization or the Lifecycle Viewer, you
can use a session file to save the state of your work. When you open the session file later, your work is
restored.

1. Choose File->Save Session.

2. Inthe Session Save As dialog box, in the Session Storage Location section, select one of the
following options:

e Attach to Base Document

Save the session within the workset revision.

4 [B5] 000028-\Warkset-1
[ 00028
B2 D00028-View
4 [gg) 00002848, 1-Warkset-1 i
[ 00002848,
o] D00028/A-View
[é] Subset-1

Wiewy
A 000026_8_1_Workset_1 |

¢ Attach to Selected Bomline

Save the session within the item revision of a selected BOM line in the assembly tree.

Note:

The Attach to Selected Bomline option is unavailable for 4GD subsets and design
components.

* Alternate Location
Save the session to a different location. Click Browse, and then specify a save location.

3. Select the Capture static structure check box to capture the current state of the document
structure as a PLM XML file.
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Save worksets in session packages for offline viewing _

Note:

integration preferences.

To load the PLM XML file and restore the capture document state when you open the session,
you must specify Load static structure (structure at time of save) in the Teamcenter

Click Save.

Save worksets in session packages for offline viewing

When you launch 4GD worksets into standalone Lifecycle Visualization or the Lifecycle Viewer, you can
save the files as a session package for offline viewing in locations without access to Teamcenter.

1.

Choose File—=Save Session.

In the Session Save As dialog box, in the Session Storage Location section, select Alternate

Location.

Click Browse and select the folder where you want to save the file.

Select the Save As Session Package check box.

In the Files section, the Package column appears with a check box for each document in the

session.

For each document that you want to include in the session package, ensure the check box is

selected.

Zession Save fs

Session Slorage Locakon

Attach to Selected Bomlne:;
@ Alternate Location:

Filies:
Mame
[EF 0 CO00Z8 A_1_Workset_Lvfz

= Decumentl
LG

[7] Capture stalic sloschure

([0 Attach to Base Document: 00002874, 1-0 arkset-1

Cihzeszion packagesh

b Save As Session Package

Session Package  Lecal

028 A1 -Workset-1 (primany) Configured StructureManaged

Type Status Package
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_ 6. Sending 4GD worksets to Lifecycle Visualization

6. Select the Capture static structure check box to capture the current state of the document
structure as a PLM XML file.

Note:

To load the PLM XML file and restore the capture document state when you open the session,
you must specify Load static structure (structure at time of save) in the Teamcenter
integration preferences.

7. Click Save.

Lifecycle Visualization features supported with 4GD data

The following limitations apply for the visualization of 4GD data in standalone Lifecycle Visualization or
the Lifecycle Viewer:

* You can open full worksets only. Other 4GD objects are not supported, including design components
outside of the context of a workset and product designs.

* Exporting to and importing from a PLM XML file does not support partition related information.
* Activelviewed partition schemes applied to individual subsets are not included in snapshot data.
* Opening individual design components or subsets within a workset are not supported.

* Merge operations are not supported.

* You cannot attach a session file to a selected subset or design component structure line.

* Massive Model Visualization (MMV) data is not supported.

* Motion datasets are not supported.

* You can create 3D markups when visualizing 4GD worksets, but you must use session files to save the
markups in Teamcenter. Individual VPL datasets are not supported in the context of worksets.

* Product views are not supported.
* Teamcenter visual issues are not supported.

* Cacheless searches are not supported with 4GD workset data. This includes Teamcenter Scoping for
visual reports and the Teamcenter filtering option available on various filter types.

* Visualization of the following advanced NX assembly operations in the context of a workset is not
supported:
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Lifecycle Visualization features supported with 4GD data _

Assembly arrangements

Geometry and transform overrides

Promoted geometry

Overrides (geometry, position, attributes) on reused design components within a product design
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7. Working with Teamcenter visual issues

Teamcenter visual issues overview

You can use Teamcenter visual issues to capture and track design problems with 2D images and 3D
models. Created and viewed in the standalone viewer or the Lifecycle Viewer, visual issues are managed
in Issue Manager.

Visual issues consist of an issue report and an issue report revision, along with an automatically
generated product view, 2D snapshot, or session file. When reviewers send an issue report revision
to the standalone viewer or the Lifecycle Viewer, the visualization data associated with the issue is
displayed in the same state it was in when the issue was created.

Configuring Teamcenter visual issues

Configuring the viewer to work with Teamcenter visual issues

Use the following Teamcenter preferences to configure the standalone viewer to work with Teamcenter
visual issues:

Use this preference To do this

ManagedIssueServer Enable the creation of Teamcenter visual issues. When you send
visualization data from Teamcenter to the standalone viewer, the viewer
is automatically configured to create Teamcenter visual issues. However, if
you also use the Teamcenter community collaboration issue management
system, you may need to set ManagedlssueServer to true for the viewer
to create issues in the Teamcenter database.

ManagedissueList Specify the URL of your visual issues list. When you choose Review
tab—->Issues group—>View Issues List . in the standalone viewer, the
browser launches and displays either the default list of visual issues (all
issue report revisions) or a filtered list.

ManagedlssueListQuery Display a customized visual issues list. When you choose Review
tab—>Issues group—->View Issues List  , in the standalone viewer, the

browser launches and displays a visual issues list consisting of issue report
revisions that match the criteria of a Teamcenter saved search.

Specify the URL of your Teamcenter issues list

You must use the Teamcenter ManagedlssueList preference to specify the URL where the issues list will
display. When you choose Review tab—Issues group->View Issues List = . in the standalone viewer,
the browser launches and displays the default list of visual issues.
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_ 7. Working with Teamcenter visual issues

1.

In Teamcenter, choose Edit->Options.

In the Options dialog box, click Search.

In Search On Preference Name, type ManagediIssuelList, and press Enter.

In Preferences List, click ManagedissuelList.

The Preference Details section displays the current settings for the ManagedlssuelList preference.
In Current Values, type the URL using this syntax:

http://<URL>/#/showChanges

Example:

http://10.200.30.400:7001/#/showChanges

Click Modify.
The preference is saved.
Click Cancel to close the Options dialog box.

In Teamcenter, select an item revision that includes visualization data, and choose File->Open in
Lifecycle Visualization.

Teamcenter sends the visualization data to the standalone viewer.
Choose Review tab->Issues group->View Issues List =, .

The configured browser displays the default visual issues list.

Note:

The default visual issues list includes all of the issue report revisions that have been created.
Alternatively, you can use a Teamcenter saved search to display only visual issues that
match predefined search criteria.

Filter the Teamcenter visual issues list

You can use a Teamcenter saved search to filter the visual issues list according to your specified criteria.

1.

In Teamcenter, choose Window —->Show View—-Search.
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Creating Teamcenter visual issues _

2. Atthe top of the Search view, click Select a Search 7 ~.

3. Inthe Change Search dialog box, expand System Defined Searches, and then select IssueReport
Revision.

4. Click OK.

The issue report revision search options are displayed.
5. Construct your search by specifying criteria such as Issue Category and Issue Assignee.
6. Atthe top of the Search view, click Add Search to My Saved Searches =;..

7. Inthe Add Search to My Saved Searches dialog box, type a name for the search, and then click
OK.

The search is saved.
8. Choose Edit—>Options.
9. Near the bottom of the Options dialog box, click Index.
Options related to specifying preferences are displayed.
10. In Search On Preference Name, type ManagedIssueListQuery, and press Enter.
11. In Preferences List, select ManagedIssueListQuery.
The Preference Details section displays the current settings for the ManagediIssueList preference.
12. In Current Values, type the name of the saved search.
13. Click Modify.

The preference is saved. When you display the visual issues list from the standalone viewer, it
includes only visual issues that match your predefined search criteria.

Creating Teamcenter visual issues

Creating Teamcenter visual issues

Teamcenter issue reports are used to capture and manage design problems. When you create a visual
issue in the Lifecycle Viewer or the standalone viewer, the state of the viewer is captured by a 2D
snapshot, product view, or session file, which is automatically attached to the issue. When reviewers
open the issue in the viewer, the associated visualization data is displayed for evaluation.
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Visual issue creation involves the following tasks:

* Understand the conditions under which different types of visualization datasets (2D snapshots,
product views, or session files) are generated and attached to visual issues.

* Create a single visual issue in the Lifecycle Viewer or the standalone viewer.
¢ Create visual issues from one or more 2D or 3D snapshots.
e Create visual issues from one or more Clearance results.

* Manually attach visualization datasets to an existing issue report revision.

Visual issue dataset creation behavior

When you create a visual issue in the Lifecycle Viewer or the standalone viewer, the state of the viewer
is captured by a 2D snapshot, product view, or session file, which is automatically attached to the issue.
The type of visualization dataset generated and associated with the visual issue varies depending upon
these factors:

This

visualization

dataset Is created under these conditions

2D snapshot A 2D image is the active document in the viewer. The image also must be associated
with an item revision, or a session file is created instead of a snapshot.

Product view A 3D model is the active document in the viewer. In addition, the following
conditions must be met:
* The model must be associated with an item revision.
* The model must be larger than a single part.
* The model must include configured product structure (dynamic product structure

referencing Teamcenter configuration settings).

* The Viewing window must not include any inserted models.
If any of these conditions are not met, a session file is created instead of a product
view.

Session file A 2D image or 3D model is the active document in the viewer.

Create Teamcenter visual issues

You can create Teamcenter visual issues in the Lifecycle Viewer or the standalone viewer.
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From Teamcenter, send an item revision that includes visualization data to the Lifecycle Viewer or
the standalone viewer.

Adjust the view of the image or model.

Tip:

Any changes you make to the state of the Viewing window are preserved by the visual issue,
including markups, measurements, and part or layer visibility.

Select the nodes in the tree that you would like to attach as problem items. If nothing is selected,
the parent node will be attached. If a leaf component node is selected, the problem item that is
associated with that issue will be the closest item revision ancestor to that leaf component node.

On the Issues toolbar, click Create and log an issue .
- Or -

In the standalone viewer, choose Review tab—Issues group—~>Add New Issue .

The Visual Issue dialog box appears.

From the Type list, choose Issue report.

Note:

Issue Report is the default issue type. Your organization may also allow you to choose from
additional issue types.

In the Name box, type a name for the issue report.

In the Data Type for state information section, choose how you want to capture the state of the
viewer:

» Session File
* Product View or 2D Snapshot

Depending upon your data and your settings in the Teamcenter Integration Visual Issue
Preferences, the viewer may generate a 2D snapshot or product view when the issue is created.
Choose one of the following Teamcenter relation types for the dataset:

* Snapshot Before Fix

* Snapshot After Fix
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8. Click OK.
The Issue Attribute Dialog appears, displaying the available attributes.
9. Inthelssue Attribute Dialog, do the following:
a. Double-click Synopsis to provide a name for the issue report revision.
The Attribute Edit dialog box appears.
b. In Value, type a name for the issue report revision.
c. Double-click any of the other attributes to add information relevant to the issue.

d. Click OK.

Note:

Depending upon the Teamcenter Integration Snapshot Preferences, you may need to
specify other information for a 2D snapshot or provide a name for a product view.

The viewer creates an issue report and an issue report revision, along with a 2D snapshot,
product view, or session file.

e. Ifa 2D snapshot or product view cannot be created, do the following to associate a new
session file with the issue:

A. If an error message is displayed, click OK to close it.
B. Inthe dialog box that asks you if you want to create a session file, click Yes.

A session file is created and attached to the visual issue.

Create Teamcenter visual issues from snapshots

You can create Teamcenter visual issues from 2D or 3D snapshots. If you have multiple snapshots, a
separate issue report is created for each selected snapshot.

1. From Teamcenter, send an item revision that includes visualization data to the Lifecycle Viewer or
the standalone viewer.

2. Create one or more snapshots.

3. Select the nodes in the tree that you would like to attach as problem items. If nothing is selected,
the parent node will be attached. If a leaf component node is selected, the problem item that is
associated with that issue will be the closest item revision ancestor to that leaf component node.
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4. Select each snapshot from which you want to create a visual issue. For multiple selections, hold Ctrl
as you click each snapshot.

Tip:

Selected snapshots have a green border.

il

5. Choose Actions—>Issues—>From Snapshots.
- Or -
In the standalone viewer, choose Review tab—Issues group—>Issues From Snapshots %

The Visual Issue dialog box appears.

6. From the Type list, choose Issue report.

Note:

Issue Report is the default issue type. Your organization may also allow you to choose from
additional issue types.

7. In the Name box, type a name for the issue report.

8. Inthe Data Type for state information section, choose how you want to capture the state of the
viewer:

* Session File
* Product View or 2D Snapshot

Depending upon your data and your settings in the Teamcenter Integration Visual Issue
Preferences, the viewer may generate a 2D snapshot or product view when the issue is created.
Choose one of the following Teamcenter relation types for the dataset:

* Snapshot Before Fix
* Snapshot After Fix

9. Click OK.
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The Issue Attribute Dialog appears, displaying the available attributes.
10. In the Issue Attribute Dialog, do the following:
a. Double-click Synopsis to provide a name for the issue report revision.
The Attribute Edit dialog box appears.
b. In Value, type a name for the issue report revision.
c. Double-click any of the other attributes to add information relevant to the issue.
d. Click OK.

e. If you selected multiple snapshots, the Issue Attribute Dialog appears for each snapshot. Add
information relevant to the issue, and click OK.

Create Teamcenter visual issues from clearance results

You can create Teamcenter visual issues from clearance results. A separate issue is created for each
specified result.

1. From Teamcenter, open a 3D model in the Lifecycle Viewer or the standalone viewer.
2. Perform a clearance check.

3. Inthe Results list, select one or more clearance results. For multiple selections, hold Ctrl as you
click each issue.

4. Right-click the clearance result, and select Create Issue(s).
The Visual Issue dialog box appears.

5. From the Type list, choose Issue report.

Note:

Issue Report is the default issue type. Your organization may also allow you to choose from
additional issue types.

6. In the Name box, type a name for the issue report.

7. Inthe Data Type for state information section, choose how you want to capture the state of the
viewer:

¢ Session File
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* Product View or 2D Snapshot

Depending upon your data and your settings in the Teamcenter Integration Visual Issue
Preferences, the viewer may generate a 2D snapshot or product view when the issue is created.
Choose one of the following Teamcenter relation types for the dataset:

* Snapshot Before Fix
* Snapshot After Fix
8. Click OK.
The Issue Attribute Dialog appears, displaying the available attributes.
9. IntheIssue Attribute Dialog, do the following:
a. Double-click Synopsis to provide a name for the issue report revision.
The Attribute Edit dialog box appears.
b. InValue, type a name for the issue report revision.
c. Double-click any of the other attributes to add information relevant to the issue.
d. Click OK.
The Save As dialog box appears.
e. Type a name for the clearance results file, and click Save.
The clearance results file is saved to the database.

f.  If you are posting multiple clearance results, the Visual Issue and Issue Attribute Dialog
dialog boxes are displayed again. Complete the steps described above for each issue.

A new visual issue is created for each clearance issue selected in the Results list.
Attach visualization data to Teamcenter visual issues
You can manually attach 2D snapshots or product views to issue report revisions.
1. Cutor copy a 2D snapshot or product view dataset.

2. Select the issue report revision.
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4 7 IR-000041/A;1-000204/A

3. Choose Edit-»Paste Special.

4. In the Paste Special dialog box, choose one of the following relations:
* Snapshot Before Fix
* Snapshot After Fix

5. Click OK.

The dataset is attached to the visual issue.

4 Ef IR-000041/A;1-000204/A
[ IR-000041/A
- g Impacted ltems
B Iﬁ Implemented By
» [y Problem tems
- | Referenceltems
- Iy Issuelmage
B Iﬁ Issue Fixed Image
» g Subset Snapshot
- Iy Snapshot Before Fix
4 |3 Snapshot After Fix
e 000204/8;1-2d 4

Note:

When an issue report revision is launched into the Lifecycle Viewer or the standalone viewer,
only 2D snapshot or product view in the Snapshot Before Fix and Snapshot After Fix
folders, or session files in the Reference Items folder, are automatically opened in the
viewer. All other pasted visualization data must be manually opened.

Reviewing Teamcenter visual issues

Reviewing Teamcenter visual issues overview

When a Teamcenter visual issue is created in the Lifecycle Viewer or the standalone viewer, an issue
report revision is added to the database, along with an associated 2D snapshot, product view, or session
file. Issue report revisions are typically accessed using issue lists in Issue Manager. You can configure
issue lists to include only visual issues that match search criteria such as Issue Category and Issue

Assignee.




Create a visual issue list in Issue Manager _

To access your issues, you can launch Issue Manager from within the Lifecycle Viewer. You can also
choose to display a list of issues from within the standalone viewer.

When you open a visual issue in the Lifecycle Viewer or the standalone viewer, the visualization dataset
associated with the issue is automatically opened and displayed. You can also expand the issue report
revision object from an issue list, manually select a visualization dataset, and send it to a supported
viewer. You can open 2D snapshots, product views, and session files in the standalone viewer or the
Lifecycle Viewer. You can also open product views in Structure Manager.

After opening a visual issue in the viewer, you can choose to update the associated visualization dataset
or delete the issue report revision object from the database.

Create a visual issue list in Issue Manager

To access visual issues in Issue Manager, you must use an issue list. You can configure your issue list to
include only issues that match specific search criteria.

1. Inlssue Manager, in the Issue Home view, click Manage Issue Lists [j.
The Manage Issue Lists dialog box appears.
2. Click Add.
A new issue list is displayed.
3. Inthelssue List Name column, click New Issue List.
4. Type a name for the issue list, and press Enter.
5. Select the Show check box.
6. For Assigned Search, choose IssueReport Revision to create a custom search.
7.  Click Configure.
The Configure Search dialog box is displayed.
8.  Set the search options, and click OK.
The Configure Search dialog box closes.
9. Click OK.

The Manage Issue Lists dialog box closes. In the Issue Home view, the new issue list is displayed.
Expand the issue list to access the issues matching your search criteria.
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Display a list of Teamcenter visual issues in the viewer

You can choose to display a list of visual issues from within the Lifecycle Viewer or the standalone
viewer.

On the Issues toolbar, click View existing issues .
- Or -
In the standalone viewer, choose Review tab-Issues group->View Issues List =

In the standalone viewer, the configured browser displays the default list of visual issues. In the Lifecycle
Viewer, the Issue Manager opens.

Note:

By default, the visual issues list displayed in the browser includes all issue report revisions. You can
also specify to display a list of visual issues that match predefined search criteria.

Search for visual issues in My Teamcenter

You can create and save custom search queries to access visual issues in My Teamcenter.
Create a saved search for visual issues

1. In My Teamcenter, choose Window-»Show View->Search.

2. Atthe top of the Search view, click Select a Search 7 ~.

3. Inthe Change Search dialog box, expand the System Defined Searches folder, and select
IssueReport Revision.

4. Click OK.
The IssueReport Revision search options are displayed.

5.  Construct your search.

Example:

In Issue ID, type IR* to display a list of every issue. To narrow the scope of the search, specify
additional search options such as Issue Category and Issue Assignee.

6. Atthe top of the Search view, click Add Search to My Saved Searches =;..




Open Teamcenter visual issues _

7. Inthe Add Search to My Saved Searches dialog box, type a name for the search.
The search is saved and listed in your My Saved Searches folder.

Use a saved search for visual issues

1. In My Teamcenter, at the top of the Search view, click Select a Search 7 ~ .

2. Inthe Change Search dialog box, expand the My Saved Searches folder, and select a saved
search.

3. Click OK.

The search is performed. If IssueReport Revisions matching your search query are found, they are
displayed in the Search Results view.

Open Teamcenter visual issues

You can send an issue report revision, along with an associated visualization dataset, to the standalone
viewer and the Lifecycle Viewer.

Do any of the following:

* To send a visual issue to the standalone viewer, select the issue report revision, and choose
File->Open in Lifecycle Visualization.

* To send a visual issue to the Lifecycle Viewer, right-click the issue report revision, and choose Send
To-Lifecycle Viewer.

The visual issue opens in the viewer and the data is displayed in exactly the same state as it was in when
the issue was created or last updated. All 2D snapshots and product views with the Snapshot Before Fix
and Snapshot After Fix relations are displayed on the Snapshots tab of the Product Workspace window
(standalone viewer) or the Snapshots view (Lifecycle Viewer). A dashed border around the thumbnail
image indicates that a product view or 2D snapshot is associated with a visual issue.
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Open Teamcenter visual issue attachments

You can open Teamcenter visual issue attachments, including 2D snapshots, product views, and session
files, in the standalone viewer or the Lifecycle Viewer. You can also open product views in Structure
Manager.

1. Expand an issue report revision.

The issue folders are displayed.

4 E:ﬁ IR-0000680/41-Assy_CompPMIFilterdviews/B-View

[ IR-000060/A

> 53 Impacted ltems

> 53 Implemented By

> 53 Problem fems
[ﬁ Reference Items

> I3 IssueImage

> |53 Issue Fixed Image

> 53 Snapshot Before Fix

» [ﬁ Snapshot After Fix

2. Expand the folders to display visualization datasets, if present.

4 [ Snapshot Before Fix
> = 20110304 -145607

Note:

For an overview of the visual issue folder structure, see Teamcenter visual issue
attachments.

3. Do any of the following:




Teamcenter visual issue attachments _

¢ To send a visualization dataset to the standalone viewer, select the dataset, and choose
File->Open in Lifecycle Visualization.

» To send a visualization dataset to the Lifecycle Viewer, right-click the dataset, and choose Send
To->Lifecycle Viewer.

* To send a product view dataset to the Structure Manager, right-click the dataset, and choose
Send To—>Structure Manager.

Teamcenter visual issue attachments

Depending upon your data and the Teamcenter Integration Visual Issue Preferences in the viewer, the
following types of visualization data may be generated automatically when Teamcenter visual issues are
created.
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Visualization dataset type Visual issue folder Example
product views Snapshot Before Fix 4 Ef} R-000067/A;1-caster3_assm/A-View
Snapshot After Fix [ IR-000067/A

» 5y Impacted Items

- g Implemented By

s [ﬁ Problem Items

5 [ﬁ Reference ltems

» g Issuelmage

- I Issue Fixed Image

4 |3 Snapshot Before Fix
s =l 20110304-145607

» 5@ Snapshot After Fix

2D snapshots Snapshot Before Fix 4 Ef R-000131/A;1-000014/A
Snapshot After Fix [ IR-000131/A
> g Impacted Items
> |5 Implemented By
- Iy Problem ltems
5 [ﬁ Reference ltems
- Iy IssueImage
- |5y Issue Fixed Image
4 |3 Snapshot Before Fix
>y 00001474 1-Multi-sheet CGM
- I Snapshot After Fix

session files Reference Items 4 Eff R-000132/A:1-visSC_20110303-135254
[Z7 IR-000132/4
- g Impacted Items
> g Implemented By
> Iy Problem ltems
4 [} Reference Items
» iy Seszion
- Iy Issuelmage
» [ﬁ Issue Fixed Image
» 5y Snapshot Before Fix
- | Snapshot After Fix

Edit Teamcenter visual issues

In the Lifecycle Viewer or the standalone viewer, you can save new snapshots to an existing Teamcenter
visual issue or delete existing snapshots from the issue. You can also update a single snapshot.

1. Open the visual issue in the standalone viewer or the Lifecycle Viewer.

2. Modify the contents of the Viewing window.
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Update a problem item when updating an issue _

3. Inthe Snapshots view (Lifecycle Viewer) or on the Snapshots tab (standalone viewer), do one of
the following:

* To save new 2D snapshots or product views to the visual issue, select the new snapshots.

* To delete 2D snapshots or product views from the visual issue, right-click the snapshots that you
want to delete, and choose Delete.

* To update a single 2D snapshot or product view, select the snapshot associated with the visual
issue.

Tip:
A snapshot associated with a visual issue has a dashed border.

::::::::::
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4.  Onthe Issues toolbar, click Update existing issue .
- Or -

In the standalone viewer, choose Review tab—Issues group—->Update Existing Issue 29

Update a problem item when updating an issue

You can update problem items attached to an issue when you are updating an issue.

Note:

To perform this update, Teamcenter lifecycle visualization must have a hosted Active Workspace
session working (either through hosting or using Active Workspace Application Connect) and must
be configured to use Active Workspace to create or update visual issues.

Because Active Workspace discontinued support for Internet Explorer in Active Workspace 6.0,
Teamcenter lifecycle visualization 14.1 and earlier can only host Active Workspace 5.2 and
earlier. Teamcenter lifecycle visualization 14.2 and later can host any supported version of Active
Workspace.

1. Open anissue that has already been created in Teamcenter lifecycle visualization.

2. Inthe assembly (or in the 3D view), select one or more problem items that you want to add to the
issue.
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3. Choose Menu—Actions—Issues—->Update Existing. The Update Snapshot dialog box is displayed.
4. (Optional) If you want to update the snapshot associated with the issue, click Yes; else, click No.

The update problem item dialog box is displayed.
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The dialog box is auto-populated with any problem items that were already attached to the issue as
indicated by an asterisk (*), and the new problem items that you selected in the assembly.

5. Select the check boxes for problem items that you wish to attach to the issue and clear the other
check boxes.

6. Click OK to accept the changes.

The issue is updated with the new problem items attached to it. You can view the updated issue in
both Teamcenter lifecycle visualization and in the Attachments tab in the hosted Active Workspace
session.

Delete Teamcenter visual issues in the viewer

You can delete Teamcenter visual issues directly in the standalone viewer or the Lifecycle Viewer.
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Open the visual issue in the standalone viewer or the Lifecycle Viewer.

On the Issues toolbar, click Delete this issue | ]

-or-

In the standalone viewer, choose Review tab—>Issues group—>Delete Issue ...

—

The issue report and issue report revision are deleted.
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8. Working with JtSimplification data

Overview of JtSimplification data

Complex JT models accessed remotely from Teamcenter often suffer from long loading times because of
the size and complexity of their data. JtSimplification datasets solve this problem by providing simplified
data for each of a model's subassemblies. When you open a JtSimplification dataset and turn on the root
node of the model, the simplified data is automatically loaded and displayed, which enables you to view
the entire 3D model much more quickly than is otherwise possible with a standard JT file. If you choose
to explore the model in greater detail, the full data for each subassembly level is loaded incrementally as
the structure is expanded in the assembly tree or in the viewing window.

JtSimplification datasets are created using the Simpgen translator, which is included with the
Teamcenter Dispatcher system. Administrators can schedule JtSimplification production from the My
Teamcenter Translation menu.

JtSimplification data is used automatically when you send the assembly into the viewer and turn on the
root node. Since the geometry from a standard JT subassembly and a simplified subassembly looks the
same in the viewing window, a gray icon % is used to represent subassemblies that consist of simplified
geometry.

=S Models
El-“[gl?drive_assemblya’.ﬁ.ﬂ -drive_aszembly [view]
— i [ drive_clip/t:1-drive_clip
— i [ drive_clip/t:1-drive_clip
= W drive_cdisk s -dive_cdisk
+ 4 W diive_hub_asmds 1 -dive_hub_asm [view]
=+ 4 W drive_innercy_asmdd: T -drive_innerncy_asm [view)
T drive_innercy_asmdt 1 -drive_innercy_asm [view]-geom
i [ drive_covindd: 1 -drive_covin
= [ drive_ring_asm/AA,1-drive_ing_asm [view)
4 W driive_outercy_asmdt1-drive_outercy_asm [view]
— i [ drive_cshaftéd 1 -drive_cshaft
— i [ drive_shaft/a: 1 -drive_shaft
L [ shaft_bazedt:1-shaft_baze

Note:

JtSimplification data requires an additional license and is supported only in the standalone viewers
and the Lifecycle Viewer within the Teamcenter Rich Client. If you do not have a license for the
JtSimplification functionality or if you load a JtSimplification dataset in an unsupported viewer, the
full model loads as standard JT data.

8-1



_ 8. Working with JtSimplification data

Using JtSimplification data with other features

When you load a JtSimplification dataset, the Viewing window displays simplified data for each of the
model's subassemblies, which may lead to unexpected results when you perform certain actions within
the viewer. The table below lists features that may exhibit non-standard behavior when used with

JtSimplification data.

Tip:

To avoid any of the limitations described below, resolve the simplified data to fully load the
assembly information and geometry.

Feature

3D file export

Snapshots

Session save

Part or assembly
properties

3D measurement

Clearance

Part Edit

Cross section

Show edges

Behavior with JtSimplification data

If you export a JtSimplification dataset, subassembly nodes that contain
JtSimplification data are not included in the exported model.

When you capture a snapshot with a JtSimplification dataset, the simplified
data is not resolved and the snapshot image is produced from the simplified
geometry.

Tip:

You can apply a snapshot that captured simplified geometry even after the
geometry is resolved.

When you save a session file with the Capture static structure check box
selected in the Session Save As dialog box, all of the JtSimplification geometry
is resolved as part of the saved session. Otherwise, the state of unresolved
simplified geometry is maintained.

When you right-click a part or assembly and select Properties, the
JtSimplification data is not resolved and the displayed geometric properties are
computed from the simplified geometry.

When you perform 3D measurements on JtSimplification datasets, the simplified
geometry is not automatically resolved.

When you perform clearance analysis with JtSimplification datasets, the
simplified geometry is not automatically resolved.

If you perform any Part Edit operation, all JtSimplification geometry is
automatically resolved and all of the parts are loaded.

If you perform any cross section operation, all JtSimplification geometry is
automatically resolved and all of the parts are loaded.

If you right-click a subassembly and select Show Edges, the JtSimplification
geometry of the selected subassembly is automatically resolved.
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Feature Behavior with JtSimplification data

Outline capture If you perform an outline capture on a JtSimplification dataset, the simplified
geometry is used to create the outline capture.

Concept If you perform any Concept appearance edit operation, all JtSimplification

appearance edit geometry is resolved and all the parts are loaded.

True Shading If you apply occurrence specific materials to simplified geometry, the affected

subassembly is resolved and fully loaded. Also, global wash and metallic material
finishes may not display as expected.

PLM XML save When you save a JtSimplification dataset as PLM XML, all JtSimplification
geometry is automatically resolved and all the parts are loaded.

Resolve and fully load JtSimplification data

When you open a JtSimplification dataset and turn on the root node of the model, the simplified data is
automatically loaded and displayed. If you want to view the contents of a subassembly in more detail,
you can manually expand the simplified structure to fully load the assembly information and geometry.

Do any of the following:

To Do this

Resolve all of the simplified In the assembly tree, right-click the root node of the model and select
data within the model Resolve All.

Resolve the next level of In the assembly tree, click the plus sign @& to the left of the

simplified data within a single ' subassembly node '%,.

subassembly
_or_
In the assembly tree, right-click the subassembly node and select
Resolve.

_or‘_
In the Viewing window, right-click geometry within the subassembly

and select Resolve.

Resolve all levels of simplified ' In the assembly tree, right-click the subassembly node and select
data within a single Resolve All.
subassembly
_or_
In the Viewing window, right-click geometry within the subassembly
and select Resolve All.

Resolve a part in the Viewing  Press Shift and then, in the Viewing window, click the part.
window
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To Do this

The viewer automatically determines the minimum set of
JtSimplification data to resolve in order to fully load the part.
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9. Using ClearanceDB with Teamcenter

Using ClearanceDB with Teamcenter

You can perform ClearanceDB analysis on product data stored in Teamcenter. Analysis of managed
product data is performed via the analyze_managed_product.pl script, which launches the processes
that evaluate the data and then automatically uploads the results to the ClearanceDB database.

ClearanceDB offers a number of options for working with Teamcenter, including:
* Analyze the data associated with BOM lines on a product-by-product basis.

* Perform a single clearance variant analysis that excludes all non-buildable part pairs from a 150%
BOM line.

* Work with Design Context to identify a series of target parts and then quickly find other relevant data
within a given proximity to those parts.

* Analyze the data associated with 4GD worksets.

You can evaluate ClearanceDB results in standalone Mockup, the Teamcenter Lifecycle Viewer, Structure
Manager, and Design Context. However, ClearanceDB results based on 4GD worksets can be evaluated
only in standalone Mockup.
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Product and system requirements

The ClearanceDB integration with Teamcenter has the following requirements:

* A properly configured and functioning ClearanceDB software environment, including the ClearanceDB
Server, Proxy, and Client tiers.

¢ A Teamcenter server.

For information about the platforms on which you can run Teamcenter lifecycle visualization,
download the appropriate platform matrix spreadsheet from Support Center.

¢ An FMS file client cache (FCC).
* A Teamcenter user account with system administrator privileges.
e Product data in the JT or PLM XML format within an item revision on the Teamcenter server.

* Absolute occurrence IDs for all BOM lines to be analyzed.

Enable batch clearance calculation for ClearanceDB

You must enable ClearanceDB functionality to utilize clearance results from your database.
1. Onthe 3D Clearance toolbar, click Clearance .

2. Choose Clearance—~>Preferences—>Requirement Components.

3. Inthe Requirement Components dialog box, select one or more of these options:

Select this option To obtain results in this way

Universal Clearance From analysis that you conduct locally in Mockup.
Requirement

Requirement Rules from According to requirement rules and conditions that you access
ClearanceDB Server in your organization's ClearanceDB Oracle database.

4. Choose Clearance->Preferences—->Result Components.

5. In the Result Components dialog box, select one or more of these options:
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Steps to analyze managed products _

Note:

You must choose General Clearance Results to work with results in the Results list.

Select this option To work with results in this way
General Clearance Results Visually display the results within Mockup.

ClearanceDB Results Upload the results to your organization's Oracle database.

6. Click OK.

Steps to analyze managed products

The following process describes the tasks needed to analyze a Teamcenter item revision in ClearanceDB:

1. Ensure that your environment meets the requirements for performing ClearanceDB analysis on
data from Teamcenter.

2. Create a ClearanceDB product, following the procedures located in ClearanceDB — Administration.
This includes the following:

The product configuration, which is required.

Note:

In a managed environment, ClearanceDB is configured by Teamcenter revision rules, so
ClearanceDB configuration names are Teamcenter revision rule names.

* Rules, at least one of which is required.
* Conditions, which are optional.

* Zones, which are optional.

Note:

The name of the product must be the same as the top-level node in the assembly. Send the
item revision containing the product data to Structure Manager to obtain the name of the top
level assembly node, which is displayed in the BOM Line column.

If you are working within a Teamcenter multifield key environment, see Configuring
ClearanceDB for multifield key data.

3. Update the global configuration options for working with Teamcenter data.
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4. Specify for ClearanceDB to use absolute occurrence IDs.
5. Specify the item and revision IDs for the top level assembly of your product.
6. Specify your web server protocol in the global .vvi file.

7. If you want to perform analysis using Teamcenter variant conditions, enable variant analysis for
Clearance.

8. If you want to cache the product data on your local machine to improve the performance of the
analysis, adjust the load_fcccache options.

9. Usetheanalyze_managed product.pl script to perform analysis on the managed product and
upload the results to the database.

Performing adhoc ClearanceDB analysis

Although ClearanceDB analysis is most frequently performed as part of a regularly scheduled batch
process from the command prompt, you can also manually analyze ClearanceDB products in real-time
within the Viewer, according to the rules and conditions associated with the product in the database.

Adhoc ClearanceDB analysis is subject to all of the considerations and restrictions of ClearanceDB
analysis, including the following:

* To analyze data from Teamcenter, you must configure ClearanceDB to work with Teamcenter-
managed data. For information on configuring ClearanceDB to work with Teamcenter, refer to the
Using ClearanceDB with Teamcenter section of ClearanceDB — Administration.

* To access ClearanceDB product information, including rules and conditions, the clearance
requirements must be set to Requirement Rules from ClearanceDB Server.

* To upload the results of adhoc ClearanceDB analysis to the ClearanceDB database, the clearance
results settings must be set to ClearanceDB Results.

Define ClearanceDB roles

To protect Teamcenter ClearanceDB data viewed in Active Workspace, assign users to one of the
ClearanceDB roles within the ClearanceDB group. For more information, see Define ClearanceDB roles in
Active Workspace.

Configuring ClearanceDB to work with Teamcenter

Teamcenter global configuration options

You must update the Clearance.cfgglobal file to match your Teamcenter environment.
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Using a text editor, open the Clearance.cfgglobal file.

Change any of the following settings in the Section 1: Teamcenter Configuration section of the file
to configure ClearanceDB to work with Teamcenter:

TC_ROOT

Specifies the Teamcenter root directory.
TC_DATA

Specifies the Teamcenter TC_DATA directory.
ObjectType or ItemRevisionType (Optional)

Specifies to perform analysis of 4GD worksets. If ObjectType=Workset, then

item, rev, and rev_rule arguments are interpreted as those of a workset. If
ObjectType=ClearanceCalculationSubset, then Modelld, ClearanceCalculationName, and
PartitionSchemes arguments are interpreted as those of a clearance calculation subset. The
plmxml_export utility will be invoked to extract the product structure from Teamcenter, rather
than the BOMwriter utility.

Modelld, ClearanceCalculationName, and PartitionSchemes are Teamcenter variables used
only for the script analyze_managed_product.pl, which runs clearance analysis on the
managed product (clearance calculation subset) in Teamcenter.

Example:

Modelld=JCB-Fastrac_id ClearanceCalculationName=CC_JCB-Fastrac
PartitionSchemes=
"Ptn0SchemePhysicalForJCB-Fastrac;Ptn0SchemeFunctionalForJCB-Fastrac"

If no Partition schemes are specified, no 4GD partition data will be exported.

TeamcenterUserld

Specifies a Teamcenter user name with Teamcenter system administration privileges. If no user
name is provided, ClearanceDB uses the operating system user name.

Note:

This is the same option as the bomwriter -u= command line argument.

TeamcenterUserPassword

This setting is deprecated. The Teamcenter user password is now stored in a separate file, and
the path to the file is specified with the TeamcenterUserPasswordFile setting. Now if the
password is specified with TeamcenterUserPassword, it is written to an unencrypted file in the
user’'s home directory with a randomly generated name beginning with CLDB.

TeamcenterUserPasswordFile

Specifies the path to a file containing the Teamcenter user password.
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Note:

This is the same option as the bomwriter -pf= command line argument.

TeamcenterUserGroupld

Specifies the Teamcenter group ID. If no group ID is provided, ClearanceDB uses the default
group of the specified Teamcenter user.

Note:

This is the same option as the bomwriter -g= command line argument.

RevisionRule

Specifies the revision rule for the product's top level product structure node, or the revision rule
of a workset when ItemRevisionType=Workset.

Note:

This is the same option as the bomwriter -revision_rule= command line argument, or
the pImxml_export -rev_rule when ItemRevisionType=Workset.

SavedVariantRule

Specifies the saved variant configuration to pass to the BOMwriter. The setting is not active
when ItemRevisionType=Workset.

LexicographicalVariantAnalysis

Defines the mode of the evaluation of variant condition relational expressions. Choose one of
the following:

No — If indeterminable variant conditions exist, the affected variant inferences are asked from
the server. This is the default.

Yes — If indeterminable variant conditions exist, evaluate them lexicographically.

Note:

Variant conditions that cannot be evaluated based on textual representations are
indeterminable.

VariantAnalysisClientTraceFile

Specifies the name for the log file of the variant analysis. By default, this is not set, and a log file
is not generated.
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Example:

VariantAnalysisClientTraceFile=cldb_variant_analysis.log

VariantAnalysisClientTraceFlags

Specified the content of the log file of the variant analysis. The trace flags are additive,
concatenated with the plus (+) character.

Example:

VariantAnalysisClientTraceFlags=CONFIGURATION+STATISTICS

Add any of the following flags:

CONFIGURATION Lists the variant analysis configuration attributes.
STATISTICS Provides the basic variant analysis statistics.
VARIANTCONDITIONS Provides details of textual variant conditions.
DETERMINABILITY Lists the determinability of variant conditions.
SATISFIABILITY Lists the satisfiability of variant conditions.
EXCLUDEDVCPAIRS  Lists excluded variant condition pairs.
EXCUDEDUIDPAIRS Lists excluded clearance element pairs as ABSOCCs.
EXCLUDEDNGIDPAIRS Lists excluded clearance element pairs as NGIDs.

IMPACT Lists the impact of variant conditions on the product structure.

Caution:

Enabling the EXCUDEDUIDPAIRS and EXCLUDEDNGIDPAIRS trace flags may result in
extremely large log files.

VariantLogicalExpression

Defines the variant condition UserValue title and BOM line property pair in the .plmxml file. This
has the form of:

“Variant Condition”:bl_variant_condition

“Variant Formula”:bl_formula

Example:

VariantLogicalExpression="VC:bl_variant_condition"
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Note:

This must match the content of the BomWriterUserAttributes setting.

RunLevel

Specifies the actions of the analyze_managed_product.pl script. Use a value from 1 to 6.

1 — In the product directory, a. vvi file is created, which is used by the BOMwriter to
generate a .pImxml file referencing the managed data.

2 — Using the .vvi and .plmxml files in the product directory, the Clearance Calculator
performs analysis upon the managed product data and generates a results file.

3 — The results file is uploaded to the ClearanceDB database.

4 — Both the RunLevel 1 and 2 actions are performed.

5 — Both the RunLevel 2 and 3 actions are performed.

6 — All of the RunLevel actions are performed, 1, 2, and 3.

BomWriterUserAttributes
Specifies the variant conditions for the BOMwriter to include in the generated .plmxml file.

Type these according to the following syntax:

target:Instance, key:myAttribute,literal:\"My Attribute Value\"

Note:

This is the same option as the bomwriter -ua= command line argument.

Example:

Use this option to include variant model related BOM line properties in the
generated .pImxml file. For example:

BomWriterUserAttributes=target:Instance, key: VC,prop: bl_variant_condition

TeamcenterWebServerPath

Specifies the Teamcenter web server path, including the protocol, host name, and port
number. Type this according to the following syntax:

TeamcenterWebServerPath=http://machine_name:port

Example:

TeamcenterWebServerPath=http://tcserver:80/tc8_2008/

JtDataStagingProcess
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Specifies to use the Teamcenter load_fcccache utility to download the model data from the
Teamcenter server to the local system for clearance analysis. Enabling this option pre-populates
the FMS client cache (FCC), which leads to faster and more reliable analysis.

Valid values are 0 (off) or 1 (on). The default value is 0.
JtDataStagingProcessErrorLimit

Specifies when to abort the analyze_managed_product.pl script, based on the following
custom error codes:

FILECOPY_FAILED
INVALID_DAKID_FORMAT
FCC_OPENFILE_FAILED
FCC_DOWNLOAD_FAILED
GET_READ_TICKET_FAILED
DATASET_READ_FAILED
PLMXML_MISSING_JT
CHMOD_FAILED
COPYOUT_CLEANUP_FAILED

You can specify a numerical value for each error code. By default, the error codes are given
values that correspond to the severity of the problem, with the lowest value representing the
most severe failure. If a value is not specified for the JtDataStagingProcessErrorLimit setting,
the script stops whenever an error occurs during the staging process.

The default value is 30.

Note:

The default values are recommended for the JtDataStagingProcessErrorLimit setting
and the related error codes. Essentially, with these defaults the clearance analysis will
abort when any of these errors occur, and you can use the reported error message to

troubleshoot the problem.

FILECOPY_FAILED

Specifies the error code that indicates a copy operation to the output directory has failed.

The default value is 20.
INVALID_DAKID_FORMAT

Specifies the error code that indicates an invalid DAKID was found.

The default value is 21.
FCC_OPENFILE_FAILED
Specifies the error code that indicates the FCC failed to open the file using the ticket.
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The default value is 22.
FCC_DOWNLOAD_FAILED

Specifies the error code that indicates a failure most likely due to a missing file in the volume.

The default value is 23.
GET_READ_TICKET_FAILED

Specifies the error code that indicates a read ticket failed.

The default value is 24.
DATASET_READ_FAILED

Specifies the error code that indicates no read access on the dataset.

The default value is 25.
PLMXML_MISSING_JT

Specifies the error code that indicates a missing JT file reference in the .plmxml file.

The default value is 26.
CHMOD_FAILED

Specifies the error code that indicates a failure to set the access mode during copy out.

The default value is 27.
COPYOUT_CLEANUP_FAILED

Specifies the error code that indicates a failure to remove a file during lifetime cleanup.

The default value is 28.
CopyOutLocation

Specifies the location for the dataset files downloaded from Teamcenter server.

The default location is the product directory in the ClearanceDB Work Area.

Note:

Do not use special characters in folder names.

BucketCount

Specifies how many directories to use for the cached files. Spreading the files over multiple
directories can lead to better performance.

The default value is 30.
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UseAbsolutelocation

Specifies to use an absolute value for the location attribute in the .plmxml file generated by the
BOMwriter. It is usually better to have a relative reference, although there are instances where
an absolute reference is required, such as when the .plmxml file is moved to a different location
from the referenced files.

The default value is No.
DirAccessMode
Specifies the access mode setting for the directories created to hold the cached files. Use a
chmod octal value. This setting is used only on Linux systems.
The default value is 0640.
FileAccessMode
Specifies the access mode setting for the cached files. Use a chmod octal value. This setting is
used only on Linux systems.
The default value is 0640.
BucketPrefix

Specifies a prefix to add to the names of directories created to hold the cached files.

The default value is RW.
FilenamePrefix

Specifies a prefix to add to the names of the cached files.

The default value is fmsr_.
CopyOutLifetime

Specifies the lifetime of the files cached in the StagingProcessDownloads directory. The
directory is scanned for files older than the specified value, which are removed. The lifetime
value is specified in seconds, where one day is equal to 86400 seconds and two weeks is equal
to 1209600 seconds.

The default value is 1209600 (two weeks).

Note:

This option requires the FilenamePrefix option to be set since it uses the prefix as
validation of ownership to prevent the accidental removal of files.

LifetimeCheck

Specifies to scan the StagingProcessDownloads directory for files older than the
CopyOutLifetime value.
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Valid values are 0 (off) or 1 (on). The default value is 0.
LifetimeChecklnterval

Specifies how often to scan the StagingProcessDownloads directory for files older than the
CopyOutLifetime value. If the directory holds many files and it is not important to check
the lifetime each time the analyze_managed_product.pl script is run, you can improve
performance by increasing the value so the check is made less frequently. If the specified
value is 10, the lifetime check occur once over the course of 10 script executions.

The default value is 10.
LifetimeProcessLimit

Specifies the maximum number of seconds the file lifetime check is allowed to continue.

The lifetime check randomly examines cached files. If the StagingProcessDownloads directory
consists of many files, this option has the effect of randomly processing a subset of files each
time the lifetime check takes place. Over time, all of the files are examined.

The default value is 300.
LogTypes
Specifies the type of logging to be reported. The following are valid log types:

NONE

ERROR
WARNING
INFORMATION
DEBUG
PERFORMANCE

ALL

Note:
Use the + sign to use multiple log types. For example, ERROR+WARNING.

RulesObject = Requirement Rules from ClearanceDB Server

Specify to perform analysis using the product's rules and conditions from the ClearanceDB
database. To enable this option, remove the number sign symbol (#) that precedes the
RulesObject = Requirement Rules from ClearanceDB Server line.

RulesObject = Variant Analysis
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Specify to perform analysis using Teamcenter variant conditions. To enable this option, remove
the number sign symbol (#) that precedes the RulesObject = Variant Analysis line.

ResultsObject = ClearanceDB Results

Specify to generate a ClearanceDB results file (ClearanceResultsDbUpload.csvcldb). To enable
this option, remove the number sign symbol (#) that precedes the ResultsObject =
ClearanceDB Results line.

Attribute=__ PLM_ABSOCC_UID, Part and Parents (Part First)

Specify to use product structure absolute occurrences. To enable this option, remove the
number sign symbol (#) that precedes the Attribute=__ PLM_ABSOCC_UID,Part and Parents
(Part First) line.

3. Save thefile.

Specify to use absolute occurrence IDs

For ClearanceDB to work with data from Teamcenter, an absolute occurrence ID is required for each
product structure node of the BOM line to be analyzed.

1. Enable absolute occurrence IDs in the global configuration options (specified in the
Clearance.cfgglobal file) by removing the number sign symbol (#) that precedes the
Attribute=__ PLM_ABSOCC_UID,Part and Parents (Part First) line.

2. Add the following entry to the process configuration (specified in the configuration.csvcldb file) for
each product:

"000092/A;1-cottonpicker (View)",EAICL_RELEVANT_PART_ATTRIBUTE,_PLM_ABSOCC_UID
Configure the Clearance.cfgproduct file

For the Clearance Calculator to analyze Teamcenter managed data, you must specify the item ID and
revision of the top level assembly of your product. If your Teamcenter data is configured with multifield
key data, you must specify the item key.

1. Use a text editor, open the Clearance.cfgproduct file for the product and provide the following
information:
ItemKey

Specifies the Teamcenter values of the multifield key properties for the item containing your
product.

Note:

This setting is applicable only to Teamcenter products configured with multifield key data.
It corresponds to the —key argument for the Teamcenter BOMwriter utility.
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You can obtain the necessary multifield key strings with the Teamcenter get_key_string
utility.

Itemld
Specifies the Teamcenter item ID of the top level assembly of your product.
ItemRevision

Specifies the Teamcenter revision of the top level assembly of your product.

2. Save thefile.

Encrypt the Teamcenter user password

You can use the Teamcenter install utility to encrypt the Teamcenter user password. The encrypted
password is stored in an external file.

1. Inan environment configured to run Teamcenter utilities, open a command prompt.

For information about configuring an environment to run Teamcenter utilities, see Manually
configure your environment for Teamcenter utilities in Utilities Reference.

2. Atthe command prompt, type:
install —encryptpwf —f=<path>
where

path is the full path and file name for the password file that you want to generate.

Example:

install —encryptpwf —f=C:\ClearanceDB_Work_Area\account_key

The install utility displays the following message:
Please enter password:

3. Type the password and press Enter.
The utility displays the following message:
Please re-enter the password:

4. Type the password again and press Enter.
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The password is encrypted and saved to the specified location.
5. Navigate to the ClearanceDB Work Area.
6. Open the Clearance.cfgglobal file or a Clearance.cfgproduct file in a text editor.

7. To specify for ClearanceDB to obtain the Teamcenter user password from the encrypted password
file, locate the TeamcenterUserPasswordFile setting, and type the full path and file name for the
password file.

Example:

TeamcenterUserPasswordFile=C:\ClearanceDB_Work_Area\account_key

8. Save thefile.

Configuring ClearanceDB for multifield key data

Multifield keys are identifiers assigned to objects to ensure their uniqueness in the database. For
example, if the item business object type is configured to use multifield keys, it is possible to have
two item objects with the same item ID.

For ClearanceDB to analyze Teamcenter data configured with multifield key data, you must do the
following:

* When running the create_product.pl script to create the product in the ClearanceDB database, append
the __PLM_ITEMREV_UID for the item revision to the product name.

To find the UID for an item revision, open the item revision in Structure Manager, and view the
bl_rev_fndOobjectld property. Include this value within brackets after the (View) suffix, enclosing the
entire product name in quotation marks, as shown below:

Example:

“000092/A;1-cottonpicker (View) [4BYKHkIYy$_loP]”

* When configuring the Clearance.cfgproduct file for the product, populate the ItemKey parameter
with the multifield key properties of the item. This setting corresponds to the —key argument for the
Teamcenter BOMwriter utility.

To obtain the key information, use the Teamcenter get_key_string utility.

Example:

ItemKey=item_id=000092,MFK_strkey1=val1
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Optionally configure Teamcenter export for 4GD worksets

When you export 4GD data to PLM XML, you can export design element properties that are in addition
to the properties that are exported by default. To do this, you must add the properties to the PLM XML
transfer mode. You may also customize the titles of the properties for the .pImxml file.

Add the property to the PLM XML transfer mode

To include the additional property, you must edit the transfer mode used for exporting data from
Teamcenter by adding the property derived from the 4GD root business object CpdODesignElement.

1. In Teamcenter, start the PLM XML/TC XML Export Import Administration application.

Note:

For more information, see the PLM XML/TC XML Export Import Administration application
documentation.

2. Select the 4GDPIEDataExportTcVisClearanceDB transfer mode from the PLM XML Import Export
Modes tree.

The TransferMode pane appears, with the options for the selected transfer mode.

3. Expand 4GDPIEDataExportTcVisClearanceDB in the left pane, and select
4GDPIEDataExportCLDB_PS.

4. Create the clause that specifies how the data is traversed:

g.

Click the Add clause button + located to the right of the clause table.
Select CLASS from the Primary Object Class Type list.

Type CpdODesignElement in the Primary Object box.

Select PROPERTY from the Relation Type list.

Type object_name in the Related Property Or Object box.

Select DO from the Property Action Type list.

Click the Modify button.

Customize the property title in the .pImxml file

When the property is added to the property set, it is exported to the PLM XML with its name as
object_name. You can change this to a more specific name.
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Open the rule file 4GD_cldb.csv at this location:
TC_DATA\xformern\LLTCXML_PLMXML

Under the CpdODesignElement business object, in the ProductRevisionView section, add the
ProductRevisionView/UserData rule as shown in this example, where DesignElementName is the
new name you want to create for the property.

HHHH I
# CpdODesignElement
HHHH T T
CpdODesignElement]Productlinstance
CpdODesignElement.object_name|Productlnstance.name
CpdODesignElement<fndOaffectedObject.MdlOVariantExprBlock.fndOexpress
ions>
CfgOApplicationVariantExp.fndOformula]Productlnstance/UserDatal
add_user_value($TARGET_END_OBJECT
CpdODesignElement.owning_user>User.user_name|Productlnstance/
UserDatal]
add_user_value($TARGET_END_OBJECT
CpdODesignElement.owning_group>Group.name|Productlnstance/UserDatal|
add_user_value($TARGET_END_OBJECT

CpdODesignElement|Productlnstance.partRef>ProductRevisionView

CpdODesignElement]Occurrence
CpdODesignElement.puid]Occurrence/UserDatal
add_user_value($TARGET_END_OBJECT
CpdODesignElement]Occurrence. instanceRefs>Productlnstance
CpdODesignElement<cpdOpresented_parent.CpdODesignElement]
Occurrence.occurrenceRefs>0ccurrence
CpdODesignElement]Occurrence.partRef>ProductRevisionView
CpdODesignElement.cpdOUG_ENTITY_HANDLE|Occurrence/UserData]
add_user_value($TARGET_END_OBJECT

CpdODesignElement|ProductRevisionView
CpdODesignElement.object_name|ProductRevisionView.name

CpdODesignElement.object_name|ProductRevisionView/UserDatajadd_user_value
($TARGET_END_OBIJECT, 'DesignElementName’, ",$SOURCE_VALUES, false, false)

CpdODesignElement.cpdOsource_object>ltemRevision.items_tag>ltem.fndOi
s

monolithic]ProductRevisionView/UserData]|
add_user_value($TARGET_END_OBJECT
CpdODesignElement<cpdOpresented_parent.CpdODesignElement]
ProductRevisionView.

instanceRefs>Productlnstance

CpdODesignElement<mdlOpositioned_object.MdlODefaultGeometry|
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ProductRevisionView/Representation
CpdODesignElement<mdlOpositioned_object.MdlODefaultGeometry.

mdlO0direct_model_data>Dataset.object_type|ProductRevisionView/

Representation.format]lookup_table( DSFormatList

Near the beginning of the file, add the ProductRevisionView rule as shown in this example.

Isource_hierarchy CpdOWorksetLine\BOMLiIne
Isource_hierarchy CpdOSubsetLine\BOMLine
Isource_hierarchy CpdOWorksetRevision\ltemRevision

Itarget_graph_definition UserValue.title

Itarget_graph_definition UserValue.value
Itarget_id_reference InstanceGraph.rootRefs]|*.id
Itarget_id_reference ProductRevisionView. instanceRefs|*.id
Itarget_id_reference ProductView.rootRefs|*.id

|ProductView/ApplicationRef._application] “NX*|
@ProductView.usage == "modelView~

| InstanceGraph . $CHILD_ELEMENT |
concat(@@InstanceGraph.$CHILD_ELEMENT>$MAPPED
| InstanceGraph . $CHILD_ELEMENT |
concat(@@InstanceGraph.$CHILD_ELEMENT>$MAPPED

|ProductView.$CHILD_ELEMENT]

concat(@@ProductView.$CHILD ELEMENT>$MAPPED

|ProductRevisionView/UserData/UserValue| remove_object($SOURCE_VALUE)|
@UserValue.title =='object_name'

HHHHHH R
# BOMWindow
HHHHHHH R

Caching managed data for analysis

You can configure ClearanceDB to use the load_fcccache utility to download and cache model data
from the Teamcenter server to your local machine, improving both the reliability and performance of the
analysis. Options to control the load_fcccache utility are located in the Clearance.cfgglobal file.

For most of these settings the default values are recommended and they should not be modified
unless you understand how the changes will affect the data staging process. Exceptions include
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 JtDataStagingProcess — By default the load_fcccache option is disabled and you must change
this setting to enable it.

* CopyOutLocation — This setting specifies where to copy the files cached from Teamcenter.

* LogTypes — This setting controls the content of the log files.

For more information on the Teamcenter File Management System (FMS), see Teamcenter
Administration in the Teamcenter help.

1. Using a text editor, open Clearance.cfgglobal and adjust the following settings:
JtDataStagingProcess

Specifies to use the Teamcenter load_fcccache utility to download the model data from the
Teamcenter server to the local system for clearance analysis. Enabling this option pre-populates
the FMS client cache (FCC), which leads to faster and more reliable analysis.

Valid values are 0 (off) or 1 (on). The default value is 0.
JtDataStagingProcessErrorLimit

Specifies when to abort the analyze_managed_product.pl script, based on the following
custom error codes:

FILECOPY_FAILED
INVALID_DAKID_FORMAT
FCC_OPENFILE_FAILED
FCC_DOWNLOAD_FAILED
GET_READ_TICKET_FAILED
DATASET_READ_FAILED
PLMXML_MISSING _JT
CHMOD_FAILED
COPYOUT_CLEANUP_FAILED

You can specify a numerical value for each error code. By default, the error codes are given
values that correspond to the severity of the problem, with the lowest value representing the
most severe failure. If a value is not specified for the JtDataStagingProcessErrorLimit setting,
the script stops whenever an error occurs during the staging process.

The default value is 30.

Note:

The default values are recommended for the JtDataStagingProcessErrorLimit setting
and the related error codes. Essentially, with these defaults the clearance analysis will
abort when any of these errors occur, and you can use the reported error message to

troubleshoot the problem.
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FILECOPY_FAILED

Specifies the error code that indicates a copy operation to the output directory has failed.

The default value is 20.
INVALID_DAKID_FORMAT

Specifies the error code that indicates an invalid DAKID was found.

The default value is 21.
FCC_OPENFILE_FAILED
Specifies the error code that indicates the FCC failed to open the file using the ticket.

The default value is 22.
FCC_DOWNLOAD_FAILED

Specifies the error code that indicates a failure most likely due to a missing file in the volume.

The default value is 23.
GET_READ_TICKET_FAILED

Specifies the error code that indicates a read ticket failed.

The default value is 24.
DATASET_READ_FAILED

Specifies the error code that indicates no read access on the dataset.

The default value is 25.
PLMXML_MISSING_JT

Specifies the error code that indicates a missing JT file reference in the .plmxml file.

The default value is 26.
CHMOD_FAILED

Specifies the error code that indicates a failure to set the access mode during copy out.

The default value is 27.
COPYOUT_CLEANUP_FAILED

Specifies the error code that indicates a failure to remove a file during lifetime cleanup.

The default value is 28.

CopyOutLocation
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Specifies the location for the dataset files downloaded from Teamcenter server.

The default location is the product directory in the ClearanceDB Work Area.

Note:

Do not use special characters in folder names.

BucketCount
Specifies how many directories to use for the cached files. Spreading the files over multiple
directories can lead to better performance.
The default value is 30.

UseAbsoluteLocation
Specifies to use an absolute value for the location attribute in the .plmxml file generated by the
BOMwriter. It is usually better to have a relative reference, although there are instances where
an absolute reference is required, such as when the .plmxml file is moved to a different location
from the referenced files.
The default value is No.

DirAccessMode
Specifies the access mode setting for the directories created to hold the cached files. Use a
chmod octal value. This setting is used only on Linux systems.
The default value is 0640.

FileAccessMode
Specifies the access mode setting for the cached files. Use a chmod octal value. This setting is
used only on Linux systems.
The default value is 0640.

BucketPrefix

Specifies a prefix to add to the names of directories created to hold the cached files.

The default value is RW.
FilenamePrefix

Specifies a prefix to add to the names of the cached files.

The default value is fmsr_.
CopyOutLifetime

Specifies the lifetime of the files cached in the StagingProcessDownloads directory. The
directory is scanned for files older than the specified value, which are removed. The lifetime
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value is specified in seconds, where one day is equal to 86400 seconds and two weeks is equal
to 1209600 seconds.

The default value is 1209600 (two weeks).

Note:

This option requires the FilenamePrefix option to be set since it uses the prefix as
validation of ownership to prevent the accidental removal of files.

LifetimeCheck

Specifies to scan the StagingProcessDownloads directory for files older than the
CopyOutLifetime value.

Valid values are 0 (off) or 1 (on). The default value is 0.

LifetimeChecklinterval

Specifies how often to scan the StagingProcessDownloads directory for files older than the
CopyOutLifetime value. If the directory holds many files and it is not important to check
the lifetime each time the analyze_managed_product.pl script is run, you can improve
performance by increasing the value so the check is made less frequently. If the specified
value is 10, the lifetime check occur once over the course of 10 script executions.

The default value is 10.

LifetimeProcessLimit

Specifies the maximum number of seconds the file lifetime check is allowed to continue.

The lifetime check randomly examines cached files. If the StagingProcessDownloads directory
consists of many files, this option has the effect of randomly processing a subset of files each
time the lifetime check takes place. Over time, all of the files are examined.

The default value is 300.

LogTypes

Specifies the type of logging to be reported. The following are valid log types:
NONE
ERROR
WARNING
INFORMATION

DEBUG
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PERFORMANCE

ALL

Note:

Use the + sign to use multiple log types. For example, ERROR+WARNING.

2. Save thefile.

Set the default owner for each clearance result

To show the default owner for clearance results, you must set the default owner attribute in the
BOMwriter, which is then included in the generated .plmxml file.

1. Inthe Clearance.cfgglobal file, add the following attribute under the BomWriterUserAttributes
section:

BomWriterUserAttributes=target: Instance,key:"ltem Revision
Owning User",prop:bl_rev_owning_user,key:"Last Modified
Date",prop:awbORevisionLastModifiedDate

2. Inthe configuration.csvcldb file, add the following attributes:
<product name>,EAICL_RELEVANT_PART_ ATTRIBUTE,Last Modified Date
<product name>,EAICL_RELEVANT_PART_ATTRIBUTE, Item Revision Owning User
<product name>,EAICL_INITIAL_CLEARANCE_OWNER_ASSIGNMENT,ON

<product name>,EAICL_INITIAL_CLEARANCE_OWNER_CHOICE, Item Revision Owning
User

<product name>,EAICL_INITIAL_CLEARANCE OWNER_CHOICE_CRITERION,Last
Modified Date

The configuration file changes can be added in the default product’s configuration.csvcldb and
then copied to all new products when they are created by using either the -uc (copy default
product's configuration.csvcldb file) or -ua (copy all default product's configuration files) flag in the
create_product.pl command line call. Alternatively, the configuration file changes can be added to
the individual product’s configuration.csvcldb file.
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Analyzing managed ClearanceDB products

Analyze managed ClearanceDB products

Analysis of managed products is performed via the analyze_managed product.pl script, which triggers
the following events in sequence:

1. The BOMwriter utility generates a .plmxml file referencing the Teamcenter product data.

2. The load_fcccache utility downloads the product data to your local machine. A second .pImxml file
referencing the cached data is generated.

3. The Clearance Calculator analyzes the cached data according to a ClearanceDB product
configuration (defined in the configuration.csvcldb file, together with any specified rules,
conditions, and zones). ClearanceDB results are generated and uploaded to the ClearanceDB
database.

Analyze a managed product

Take the following steps to perform a ClearanceDB analysis upon a Teamcenter managed product.
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1. Configure the Clearance Calculator, as described in the Configure the Clearance Calculator section
in ClearanceDB — Administration.
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2. Navigate to the appropriate product directory in your ClearanceDB Work Area.
3.  From the command prompt, type

analyze managed_ product.pl <product>

Example:

analyze_managed_product.pl flux_capacitor

Depending upon how you set the RunLevel parameter in the Clearance.cfgglobal file, one or
more of the following actions are performed:

This RunLevel Does this
setting

1 In the product directory, a .vvi file is created, which is used by the BOMwriter to
generate a .pImxml file referencing the managed data.

2 Using the .vvi and .pImxml files in the product directory, the Clearance
Calculator performs analysis upon the managed product data and generates
a results file.

The results file is uploaded to the ClearanceDB database.
Both the RunLevel 1 and 2 actions are performed.

Both the RunLevel 2 and 3 actions are performed.

o 0o b~ W

All of the RunLevel actions are performed, 1, 2, and 3.

The analysis runs, and when it is complete the clearance results file,
ClearanceResultsDbUpload.csvcldb, appears in the product directory.

Example output from managed analysis

The command line output below is from a successful ClearanceDB analysis of a Teamcenter managed
product.

C:\ClearanceDB_Work_Area\Products\141-f10002_A_1-
Front_Suspension__view_>analyze_managed_product.pl

# Teamcenter Configuration:
# TC_ROOT=Y:\
# TC_DATA=Z:\
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# TeamcenterUserld=tcuser

# RevisionRule=Latest Working
# RunLevel=6

# JtDataStagingProcess=1

"141-f10002_A_1-Front_Suspension__view_.vvi' Ffile is
created in the product directory. Please
verify it.

Running:

Y:\\bin\bomwriter -u=tcuser —p=XXXXXXXX

-g= -item="141-f10002" -rev=A -format=plmxml+type=
AbsoluteOccurrences+ua=target:Root,key:Configuration, literal:"Latest Working"
-revision_rule="Latest

Working"™ -output_file="C:/ClearanceDB_Work_Area/Products/141-f10002_A_1-
Front_Suspension__view_/

141-f10002_A_1-Front_Suspension__view_.pImxml*

platform=MSWin32

C:/ClearanceDB_Work_Area/Products/141-f10002_A 1-Front_Suspension__view_/
bomwriter_exec.bat

C:\ClearanceDB_Work_Area\Products\141-f10002_A 1-Front_Suspension__view_>set TC_ROOT=Y:\

C:\ClearanceDB_Work_Area\Products\141-f10002_A 1-Front_Suspension__view_>set TC_DATA=Z:\

C:\ClearanceDB_Work_Area\Products\141-f10002_A_1-Front_Suspension__view_>call
Z:\\tc_profilevars

# Bomwriter.exe execution SUCCEEDED
# Execution time = 00:15:03

Staging process uses config file: C:/ClearanceDB_Work_ Area/Clearance.cfgglobal

The staging process saved the original plmxml as: C:/ClearanceDB_Work_Area/Products/
141-f10002_A_1-Front_Suspension__view_/141-f10002_A_ 1-Front_Suspension__view__orig.plImxml
Warning: Invalid "CopyOutLocation™ in the configuration file. Use product dir by default.

Running:

Y:\\bin\load_fcccache -u=tcuser -—p=XXXXXXXX
-config=C:/ClearanceDB_Work_Area/Clearance.cfgglobal

-f=load -pImxml=C:/ClearanceDB_Work_Area/Products/141-f10002_A 1-Front_Suspension__view_/
141-f10002_A_1-Front_Suspension__view__orig.pImxml -output_plmxml=C:/
ClearanceDB_Work Area/
Products/141-f10002_A_1-Front_Suspension__view_/141-f10002_A_1-
Front_Suspension__view_.pImxml
-copy_out=C:/ClearanceDB_Work_Area/Products/141-f10002_A_1-Front_Suspension__view_/
StagingProcessDownloads -log_filename=C:/ClearanceDB_Work_Area/Products/
141-f10002_A_1-Front_Suspension__view_/JtDataStagingProcess. log

platform=MSWin32
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C:\ClearanceDB_Work_Area\Products\141-f10002_A 1-Front_Suspension__view_>set TC_DATA=Z:\

C:\ClearanceDB_Work_Area\Products\141-f10002_A_1-Front_Suspension__view_>call
Z:\\tc_profilevars

DEBUG
DEBUG
DEBUG
DEBUG
DEBUG
DEBUG
minor
DEBUG
DEBUG
DEBUG
DEBUG
minor
DEBUG
DEBUG
DEBUG
DEBUG
DEBUG
DEBUG
DEBUG
DEBUG
DEBUG
DEBUG

2023-02-09T19:21:
2023-02-09T19:21:
2023-02-09T19:21:
2023-02-09T19:21:
2023-02-09T19:21:
2023-02-09T19:21:

16.4627:
16.4627:
16.4787Z:
16.4787:
16.4787:
16.4787:

Setting
Setting
Setting
Setting
Setting
Setting

logTypes to:

minor
minor
minor
minor

error:
error:
error:
error:

error: GET_READ TICKET_FAILED, error code: 24
2023-02-09T719:21:16.493Z: Setting minor error:
2023-02-09T19:21:16.493Z: Setting minor error:
2023-02-09T19:21:16.493Z: Setting minor error:
2023-02-09T19:21:16.493Z: Setting
error: COPYOUT_CLEANUP_FAILED, error code: 28
BucketCount to: 30

UseAbsolutelLocation to: No

DirAccessMode to: 0750 (488)

FileAccessMode to: 0640 (416)

BucketPrefix to: RW

FilenamePrefix to: fmsr_

CopyOutLifetime to: 1209600

LifetimeCheck to: O

the LifetimeChecklnterval to: 10

the LifetimeProcessLimit to: 300

FCC Interface Implementation fms.8.2.0.20091029.01(fms.8.2.0.20091029.01) initialized.

2023-02-09T19:21:
2023-02-09T19:21:
2023-02-09T19:21:
2023-02-09T19:21:
2023-02-09T19:21:
2023-02-09T19:21:
2023-02-09T19:21:
2023-02-09T19:21:
2023-02-09T19:21:
2023-02-09T19:21:

16.5097:
16.5097:
16.603Z:
16.618Z:
16.618Z:
16.618Z:
16.618Z:
16.618Z:
16.618Z:
16.634Z:

Setting
Setting
Setting
Setting
Setting
Setting
Setting
Setting
Setting
Setting

# Load_fcccache.exe execution SUCCEEDED
# Execution time = 00:13:05

Running:
C:/ClearanceDB_Work_Area/Products/141-f10002_A 1-Front_Suspension__view_/
clearance_exec.bat
C:\ClearanceDB_Work_Area\Products\141-f10002_A_1-Front_Suspension__view_>set
VP_AUTO_TESTING=True

-1

FILECOPY_FAILED, error code: 20
INVALID DAKID FORMAT, error code: 21
FCC_OPENFILE_FAILED, error code: 22
FCC_DOWNLOAD_FAILED, error code: 23

DATASET _READ_ FAILED, error code: 25
PLMXML_MISSING_JT, error code: 26
CHMOD_FAILED, error code: 27

C:\ClearanceDB_Work_Area\Products\141-f10002_A_ 1-Front_Suspension__view_>set
EAI_CL_DATASOURCE=
cldbmachine:7206

C:\ClearanceDB_Work_Area\Products\141-f10002_A_ 1-Front_Suspension__view_>set
EAI_CL_CONNECT_DATA=
CLDB_PROXY_CONNECT

C:\ClearanceDB_Work_Area\Products\141-f10002_A_1-Front_Suspension__view_>set
PATH=C:\PerlI\bin;
C:\WINDOWS; C:\WINDOWS\System32;C:\vis\Products\Mockup\ClearanceDB

C:\ClearanceDB Work Area\Products\141-f10002 A 1-
Front_Suspension__view_>C:\vis\Products\Mockup\
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clearance.exe -d 5 -c
C:/ClearanceDB_Work_Area/Products/141-f10002_A 1-Front_Suspension__view_/
141-f10002_A_1-Front_Suspension__view_.vvi

Teamcenter Visualization Clearance Testing.

Launching worker process.

Creating clearance components.

Loading input file.

Performing clearance test.

Generating pairs.

Product = 141-f10002/A;1-Front Suspension (view)(Latest Working)

2023/02/09-14:30:41: Connected to ClearanceDB Proxy on machine cldbmachine, at port 7206.

2023/02/09-14:30:44: Reconnected to

ClearanceDB Proxy on machine cldbmachine, at port 7206.

2023/02/09-14:30:45: Reconnected to

ClearanceDB Proxy on machine cldbmachine, at port 7206.

Number of unique rules =1

2023/02/09-14:30:48: Reconnected to

ClearanceDB Proxy on machine cldbmachine, at port 7206.

2023/02/09-14:30:49: Reconnected to

ClearanceDB Proxy on machine cldbmachine, at port 7206.

The statistics of 141-f10002/A;1-Front Suspension (view):
Number of element occurrences = 55
Number of unchanged element occurrences 0
Number of excluded element occurrences 0

The requirement engine called total of 1461 times.
Clearance test bed has been created with

CADID matching keyed by PART names.

All pairs have been generated.

Processing pairs.

Launching 2 processes for analysis.

Process 1: All pairs have been processed.

Process 2: All pairs have been processed.
Generating results.

Testing finished. Results written to "ClearanceResultsDbUpload.csvcldb®.
Process ended normally.

# Clearance.exe execution SUCCEEDED
# Execution time = 00:01:12

Running:
C:\vis\Products\Mockup\ClearanceDB\update_product.pl -ud

No local .dbc file in the product directory.
Looking for global version(s) in ClearanceDB_Work_Area directory ....

Uploading via ClearanceDb Proxy .....
2023/02/09-14:31:09: Connecting to Clearance Database...

2023/02/09-14:31:09: Connected to ClearanceDB Proxy on machine cldbmachine, at port 7206.
2023/02/09-14:31:09: Successfully connected to Clearance Database.
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2023/02/09-14:31:09: Lock the Clearance Database for results update...

2023/02/09-14:31:11: Starting upload for C:/ClearanceDB_Work_Area/Products/
141-f10002_A_ 1-Front_Suspension__view_/ClearanceResultsDbUpload.csvcldb ...

2023/02/09-14:31:11: 100% complete.

2023/02/09-14:31:11: Starting merge results.
This could take quite a while, please be patient...

2023/02/09-14:31:17: Merge successful.

2023/02/09-14:31:17: Upload successful.

He -

# Update_product.pl execution SUCCEEDED

# Execution time = 00:00:08

He -

H e -
# analyze _managed_product._pl complete

#

# Step la: Bomwriter.exe. Result = SUCCEEDED. Time=00:15:03
# Step 1lb: Load_fcccache.exe. Result = SUCCEEDED. Time=00:13:05
# Step 2: Clearance.exe. Result = SUCCEEDED. Time=00:01:12
# Step 3: Update_product.pl. Result = SUCCEEDED. Time=00:00:08
# Total Time = 00:29:31

H e

Completed: Tue Feb 9 14:31:17
C:\ClearanceDB_Work_Area\Products\141-f10002_A_ 1-Front_Suspension__view_>

View results in the Lifecycle Viewer and Structure Manager

View results in the Lifecycle Viewer

In My Teamcenter, right-click the item revision containing your product data and choose Send
To-Lifecycle Viewer.

The dataset opens in the Lifecycle Viewer.
Choose Clearance—>Preferences—>Requirement Components.

In the Requirement Rule Components dialog box, select the Requirement Rules from
ClearanceDB Server check box, and then click OK.

On the 3D Clearance toolbar, click Load Results .

In the Load Clearance Results dialog box, from the Files of Type list, choose ClearanceDB
DataBase Connection (*.dbc).
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6. Select your DataBase Connection (DBC) file, and click Open.

The 3D model and the database content are matched by the name of the top-level assembly node.
Results are displayed in the Results list.

View results in Structure Manager

1. In My Teamcenter, right-click the item revision containing your product data and choose Send
To-Structure Manager.

The Structure Manager opens and displays the product structure.
2.  Choose View—>Show/Hide Data Panel.
3. Inthe Data Panel, click the Viewer tab.

The visualization components load and the Structure Manager embedded viewer opens.
4. Choose Graphics—>Clearance—>Preferences—>Clearance—>Requirements.

5. In the Requirement Rule Components dialog box, select the Requirement Rules from
ClearanceDB Server check box, and then click OK.

6. Right-click the embedded viewer toolbar area and choose 3D Clearance.

The 3D Clearance toolbar is displayed.
7. On the 3D Clearance toolbar, click Load Results .

8. Inthe Load Clearance Results dialog box, from the Files of Type list, choose ClearanceDB
DataBase Connection (*.dbc).

9. Select your DataBase Connection (DBC) file, and click Open.

The 3D model and the database content are matched by the name of the top-level assembly node.
Results are displayed in the Results list.

Working with Design Context

Work with Design Context

You can combine ClearanceDB with Teamcenter's Design Context application to create an Integrated
Clearance Management (ICM) system. Design Context identifies a series of target parts and then quickly
finds other relevant data within a given proximity to those parts. This data can be sent to ClearanceDB
to perform clearance analysis in database query (batch) mode or real-time mode. Results are displayed
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in Design Context, and also can be sent to the Structure Manager, the Lifecycle Viewer, or standalone
Mockup for display and further analysis.

ClearanceDB accepts any pruned or full product structure provided it is represented by a JT file in the
Teamcenter database. Any parts for which JT data is not available are not included in the clearance
analysis. The product structure also should be searchable in Design Context.

The ICM system offers two clearance analysis modes:
* Database query mode

In database query mode, the ClearanceDB administrator creates a batch process to perform clearance
analysis periodically as a background task, typically every night. The batch process invokes the
Clearance Calculator to perform the analysis and uploads the results to the ClearanceDB database.
The Design Context end user can then evaluate the results, identify issues, and assign the issues via

a workflow to designers to analyze and resolve within other applications such as the Lifecycle Viewer,
Structure Manager, NX, or other CAD package.

¢ Real-time mode

In real-time mode, the rich client user selects target and background Bill of Materials (BOM) lines in
Design Context, and then invokes a clearance analysis that is performed in real time. Typically, this
option is used to make on-the-fly clearance calculations after design changes or prior to releasing a
part. Teamcenter runs these calculations in the background, allowing the end user to continue with
other work while waiting for the results. Results are displayed in the Design Context Issues panes.

A SCO (Structure Context Object) containing the clearance results can also be created in the Newstuff
folder, provided the RDVCreateSCOForClearance preference is set to true. The SCO can be opened
in a subsequent session to retrieve the selected product structure lines and analysis results.

Note:

For more information on using Design Context, see Design Context in the Teamcenter help.

Design Context clearance analysis modes

Database query mode

The ClearanceDB administrator configures the scope of the analysis and the Design Context end user can
only view the results. The end user can use the Design Context search engine capabilities to focus upon
particular parts.

Clearance issues are displayed in one of the following Issues panes:

* Target-Target Issues
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Shows clearance issues among all the appearances in the Design Context target appearances table in
the third window. The specific issue between each pair of parts is listed.

* Target-Background Issues

Shows clearance issues among target parts against all the appearances in the Design Context
background appearances table in the third window. The specific issue between each pair of parts
is listed.

* Target-Other Issues

Teamcenter displays each pair of parts that violate one of the defined clearance rules. All violations are
shown in the context of the selected target part appearance or appearances. For each violation, the
following information is listed:

* Type
The clearance violation type.
* Result
The calculated violation with respect to the requirement.
* Requirement
The required clearance.
* Location

The x,y,z coordinates of the violation.

Note:

You can also view additional results information such as issue Status, Priority, and Date
First Found. To update the selection of columns shown in the Issues panes, modify the
ClearanceDBShownColumns preference in the rich client.

Real-time mode

Real-time clearance analysis is a two step process. The first step is to create search criteria for the
clearance calculation. The second step is to send the search criteria to Design Context to see the
clearance analysis results.

To perform real-time clearance analysis, the end user manually selects BOM lines of interest in Design
Context. BOM lines involved in the analysis process are Design Context target parts. The user selects
these parts from the target and background BOM lines that are configured in the Design Context third
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window. Global background parts cannot be included in a real-time clearance analysis. If particular BOM
lines are not selected, all BOM lines in the target appearances are considered target parts.

Teamcenter analyzes the BOM lines selected as Design Context target parts against all other BOM lines in
the Design Context third window. It presents the issues in the following categories:

» Target parts against all the appearances in the Design Context target appearances table in the third
window.

* Target parts against all the appearances in the Design Context background appearances table in the
third window.

Optionally, Teamcenter may create an SCO (Structure Context Object) in the Newstuff folder containing
information about the session. The SCO can be opened in a subsequent session to retrieve the selected
product structure lines and analysis results.

Note:

Creation of an SCO is optional and occurs only if the RDVCreateSCOForClearance preference is
set to true in the rich client.

Specify connection information for Design Context

For Design Context to connect with the ClearanceDB database, you must use the Teamcenter
RDVClearanceProxyServers preference to specify the ClearanceDB connection information.

Note:

You must have Teamcenter administrator rights to modify the RDVClearanceProxyServers
preference.

1. Log on to the rich client as the administrator.
2. Choose Edit->Options.
3. Atthe bottom of the Options dialog box, click Search.

4. In the Search On Keywords box, type RDVClearanceProxyServers, and then click the
magnifying glass icon to search for the preference.

5. Inthe Preferences List, select RDVClearanceProxyServers.
6. Inthe Current Values box, type your connection information according to the following syntax:

<machine_name>:<port>:<connection_name>
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where

For this parameter ' Type this
machine_name The name of the system running the ClearanceDB Proxy or Oracle Client.
port The port number used for the ClearanceDB connection.

connection_name The name of the Oracle connection.

7.  Click the + sign to the right of the Current Values box.

Note:

The RDVClearanceProxyServers preference can consist of multiple ClearanceDB
connections. For each additional connection that you want to establish, type the required
connection information as described above and then click the + sign to the right of the
Current Values box to update the preference.

8. Click Modify.

Specify to create an SCO for clearance results

Set the RDVCreateSCOForClearance preference to true if you want to create an SCO (Structure
Context Object) after performing real-time analysis.

Note:

You must have Teamcenter administrator rights to modify the RDVCreateSCOForClearance
preference.

1. Logon to the rich client as the administrator.
2. Choose Edit=Options.
3. Atthe bottom of the Options dialog box, click Search.

4. Inthe Search On Keywords box, type RDVCreateSCOForClearance, and then click the
magnifying glass icon to search for the preference.

5. In the Preferences List, select RDVCreateSCOForClearance.
6. Inthe Current Values box, type true.

7.  Click Modify.
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Display additional clearance results information

Modify the ClearanceDBShownColumns preference to display additional clearance results information
in the Design Context Issues panes.

Note:

You must have Teamcenter administrator rights to modify the ClearanceDBShownColumns
preference.

Log on to the rich client as the administrator.
Choose Edit-»Options.
At the bottom of the Options dialog box, click Search.

In the Search On Keywords box, type ClearanceDBShownColumns, and then click the
magnifying glass icon to search for the preference.

In the Preferences List, select ClearanceDBShownColumns.

In the Current Values box, type the names of the ClearanceDB results columns that you want to
display.

Click Modify.

Load ClearanceDB results in Design Context

Choose Tools=Clearance Analysis.
In the Clearance Analysis dialog box, select Query the database for existing results.
Click Start Analysis.

After a delay that depends on the quantity of stored data, Teamcenter displays the retrieved
clearance issues in one of the Issues panes.

To view the associated parts in the embedded viewer, select one or more issues and click the
Communicate to Design Context button.

Teamcenter opens the relevant BOM lines in Design Context, allowing you to examine the
clearance details in the embedded viewer.

Alternatively, you can also view the parts associated with one or more selected issues in standalone
Teamcenter lifecycle visualization mockup if you click the Start/Open In TcVis % button.
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Perform real-time analysis

1.  Select the product structure lines of interest in the third Design Context window. If you do not
select any lines, Teamcenter includes all appearances in the third Design Context window in the
analysis.

2. Choose Tools->Clearance Analysis.

3. Inthe Clearance Analysis dialog box, select Perform Real-Time Clearance Analysis.

4.  Click Start Analysis.

A progress bar shows the percentage completion of the calculation, and you can click Cancel above
the progress bar to terminate the process if necessary. After a delay that depends on the scope of
the query, Teamcenter displays the clearance issues in one of the Issues panes.

5. Click OK on the form.

Note:

Real-time analysis results are not stored in the ClearanceDB database. If you want to preserve
them, you must create an SCO (Structure Context Object) object. You can open the SCO in a
subsequent session to retrieve the selected product structure lines and analysis results. The
RDVCreateSCOForClearance preference must be set to true for an SCO to be created.

Open clearance results in an SCO

1. Inyour Newstuff folder, right-click the SCO containing your results and choose Send To-»Design
Context.

Teamcenter opens the results in the first Design Context window.
2.  Click Finish.

Teamcenter opens the third Design Context window.

Note:

Click Yes on any confirmation dialog boxes that are displayed.

3. Choose Tools=Clearance Analysis.
Teamcenter displays the Clearance Analysis dialog box.

4. Select Display Cached Results from SCO and then click Start Analysis.
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After a delay that depends on the quantity of stored data, Teamcenter displays the retrieved
clearance issues in one of the Issues panes.

Working with variants

Understanding variant-based clearance analysis

Variant-based clearance analysis uses product variant information stored in Teamcenter. Analyses can be
performed on a 150% BOM structure, which is the union of two or more product variants. Non-buildable
combinations of product structure are detected and excluded from the clearance analysis.

The benefits of removing non-buildable occurrence relationships from the ClearanceDB analysis include
the following:

* Eliminate results between non-buildable product configurations.
* Faster clearance analysis.

* Fewer clearance incidents for engineers and designers to evaluate.
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A simple example with variant conditions (150% BOM with variants)

Using variant analysis, a single 150% BOM can contain all buildable product combinations. This enables
you to perform a single clearance analysis, which excludes all non-buildable part pairs.

_+ These nodes

-/ can never exist
together in the
same vehicle

These nodes
exist in all
variants
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With no variants, all nodes are analyzed (15 part pairs).

No nodes are excluded. ; X
3| X|X
4 [ X|X|[X
5 X | X[ X|X
6 X |X|[X|X]|X

With the E=V6 variant, nodes 1, 2, 3, and 4 are analyzed (6 part pairs).

Nodes 5 and 6 are excluded (9 part pairs).

>
>

O AW N =
>
>
>

1 23 4 56
With the E=V8 variant, nodes 1, 2, 5, and 6 are analyzed (6 part pairs).

. 1
Nodes 3 and 4 are excluded (9 part pairs). 2 [ x
3
4
5[X|X
6| X|X X
9-40 Lifecycle Visualization Integration With Teamcenter, Teamcenter 2412
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A simple example without variant conditions (separate 100% BOMs)

Without using variant analysis, you must create and manage separate 100% BOMs to represent each
buildable product combination. You must evaluate each BOM with a separate clearance analysis.

For the analysis of the V6 Engine, without variant conditions, nodes 1, 2, 3, and 4 123 4
are analyzed (6 part pairs). 1
No nodes are excluded. 2| X
3[x|x
4 | X[ X | X
. . . . . 1 25 6
For the analysis of the V8 Engine, without variant conditions, nodes 1, 2, 5, and 6
are analyzed (6 part pairs). 1
No nodes are excluded. 2| X
51X | X
6| X |X|X

For more information about working with Teamcenter variant conditions, see Structure Management on
Rich Client — Usage in the Teamcenter help.

Variant-based clearance analysis methods
You can perform variant-based clearance analysis using the following methods:
* Client-side

* No Teamcenter connection is required during the analysis.
* Can only be run in batch using Clearance.exe.

e Server-side
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* Requires a connection to Teamcenter Product Configurator during the analysis.
* Can be run either interactively in Teamcenter lifecycle visualization or in batch using Clearance.exe.

See Product Configurator on Rich Client to learn more about creating, modifying, and managing variants
in Teamcenter.

Teamcenter lifecycle visualization

Variant-based
clearance analysis

Client mode

Legacy method
(still available)

= Batch only

Server mode

Requires
Teamcenter Product
Configurator

= Available in 13.3
and up

Variant-based clearance analysis (client-side)

You must enable the option to evaluate ClearanceDB products according to Teamcenter variant
conditions.

1. Using a text editor, open Clearance.cfgglobal and adjust the following settings:

Note:

You can also specify these options in the Clearance.cfgproduct file for the product.

LexicographicalVariantAnalysis

Defines the mode of the evaluation of variant condition relational expressions. Choose one of
the following:
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No — If indeterminable variant conditions exist, the affected variant inferences are asked from
the server. This is the default.

Yes — If indeterminable variant conditions exist, evaluate them lexicographically.

Note:

Variant conditions that cannot be evaluated based on textual representations are
indeterminable.

VariantAnalysisClientTraceFile

Specifies the name for the log file of the variant analysis. By default, this is not set, and a log file
is not generated.

Example:

VariantAnalysisClientTraceFile=cldb_variant_analysis.log

VariantAnalysisClientTraceFlags

Specified the content of the log file of the variant analysis. The trace flags are additive,
concatenated with the plus (+) character.

Example:

VariantAnalysisClientTraceFlags=CONFIGURATION+STATISTICS

Add any of the following flags:

CONFIGURATION Lists the variant analysis configuration attributes.
STATISTICS Provides the basic variant analysis statistics.
VARIANTCONDITIONS Provides details of textual variant conditions.
DETERMINABILITY Lists the determinability of variant conditions.
SATISFIABILITY Lists the satisfiability of variant conditions.
EXCLUDEDVCPAIRS  Lists excluded variant condition pairs.
EXCUDEDUIDPAIRS  Lists excluded clearance element pairs as ABSOCCs.
EXCLUDEDNGIDPAIRS Lists excluded clearance element pairs as NGIDs.

IMPACT Lists the impact of variant conditions on the product structure.

Caution:

Enabling the EXCUDEDUIDPAIRS and EXCLUDEDNGIDPAIRS trace flags may result in
extremely large log files.
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VariantLogicalExpression

Define the variant condition UserValue title and BOM line property pair in the .pImxml file. This
has the form of:

“Variant Condition”:bl_variant_condition

“Variant Formula”:bl_formula

Example:

VariantLogicalExpression="VC-V6:bl_variant_condition"

Note:

This must match the content of the BomWriterUserAttributes setting.

BomWriterUserAttributes

Specify the variant conditions for the BOMwriter to include in the generated .pImxml file. Type
these according to the following syntax:

target:Instance, key:myAttribute,literal:\"My Attribute Value\"

Note:

This is the same option as the bomwriter -ua= command line argument.

Example:

Use this option to include variant model related BOM line properties in the
generated .pImxml file. For example:

BomWriterUserAttributes=target:Instance, key: VC-V6,prop: bl_variant_condition

RulesObject = Variant Analysis

Specify to perform analysis using Teamcenter variant conditions. To enable this option, remove
the number sign symbol (#) that precedes the RulesObject = Variant Analysis line.

2. Save the file.
Variant-based clearance analysis (server-side)
Performing variant-based clearance analysis in Lifecycle Visualization

1. With an unconfigured .pImxml file open, choose Menu->Clearance->Preferences—>Product
Configurator.
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2. Inthe Product Configuration dialog box, do the following.
a. Select the Enable Product Configurator check box.

b.  From the Variant Rule dropdown, select the desired variant rule or criteria to apply against
the loaded file during clearance analysis.

c. Click OK.
3.  Runa clearance analysis.
Performing variant-based clearance analysis in batch

To perform variant analysis in batch mode (Clearance.exe) using Teamcenter Product Configurator,
complete the following steps.

1. Ensure that you are connected to Teamcenter and that the connection is maintained for the
duration of the analysis process.

2. Using a text editor, open Clearance.cfgglobal and adjust the following settings:

Note:

You can also specify these options in the Clearance.cfgproduct file for the product, which will
override settings in the Clearance.cfgglobal file.

EnableProductConfigurator

Enables Clearance.exe to use the Teamcenter Product Configurator to perform variant analysis.

Example:

EnableProductConfigurator=True

ProductConfiguratorVariantRule

Specifies the saved variant rule that is used for communicating with the Product Configurator.

Example:

ProductConfiguratorVariantRule=<valid variant rule>

VariantLogicalExpression

Define the variant condition UserValue title and BOM line property pair in the .pImxml file. This
has the form of:
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“Variant Condition”:bl_variant_condition

“Variant Formula”:bl_formula

Example:

VariantLogicalExpression="VC-V6:bl_variant_condition"

Note:

This must match the content of the BomWriterUserAttributes setting.

BomWriterUserAttributes

Specify the variant conditions for the BOMwriter to include in the generated .pImxml file. Type
these according to the following syntax:

target:Instance, key:myAttribute,literal:\"My Attribute Value\"

Note:

This is the same option as the bomwriter -ua= command line argument.

Example:

Use this option to include variant model related BOM line properties in the
generated .pImxml file. For example:

BomWriterUserAttributes=target:Instance, key: VC-V6,prop: bl_variant_condition

3. Save thefile.
Using ClearanceDB with Active Workspace

Using ClearanceDB with Active Workspace

The ClearanceDB with Active Workspace client uses a web service to connect to the ClearanceDB. For
more information, see Connect to an existing 3D Clearance database using Deployment Center.
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Clone stable IDs

To view clearance results in Active Workspace, you must specify the clone stable ID for the BOMwriter to
include in the generated .pImxml file. You can specify this attribute in the Clearance.cfgglobal file if you

do not have specific metadata for every product, or in the Clearance.cfgproduct file if you have product
metadata.

Add the following attribute under the BomWriterUserAttributes section in either of the files identified
above.

BomWriterUserAttributes=target: Instance,key: PLM CLONE_STABLE_INST_UID,prop
:bl_clone_stable_occurrence_id
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Note:

After adding this attribute to either the Clearance.cfgglobal or Clearance.cfgproduct file, run the
update_ngids.pl utility for each product to ensure that the clearance results for each product can
be viewed in Active Workspace.

Run the clone stable IDs utility

After adding the clone stable ID attribute to either the Clearance.cfgglobal or Clearance.cfgproduct
file, you must run the update_ngids.pl utility for each product to ensure that the clearance results for
each product can be viewed in Active Workspace. If you add the attribute but do not run the utility,
when the clearance results are updated your end users may not be able to view the updated results in
Active Workspace.

1. Inan environment configured to run Teamcenter utilities, open a command prompt.

For information about configuring an environment to run Teamcenter utilities, see Manually
configure your environment for Teamcenter utilities in Utilities Reference.

2. Atthe command prompt, type:
update_ngids.pl

3. Run the utility for each product you want to view in Active Workspace.
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